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All rights reserved. No part of this publication may be reproduced in any form or by 
any electronic or mechanical means, including photocopying and recording, 
without permission in writing from GE Fanuc Automation North America, Inc.

Disclaimer of Warranties and Liability

The information contained in this manual is believed to be accurate and reliable. 
However, GE Fanuc Automation North America, Inc. assumes no responsibilities for 
any errors, omissions or inaccuracies whatsoever. Without limiting the forgoing, GE 
Fanuc Automation North America, Inc. disclaims any and all warranties, expressed 
or implied, including the warranty of merchantability and fitness for a particular 
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described herein. The entire risk as to the quality and performance of such 
information and software is upon the buyer or user. GE Fanuc Automation North 
America, Inc. shall not be liable for any damages, including special or 
consequential damages, arising out of the use of such information or software, even 
if GE Fanuc Automation North America, Inc. has been advised in advance of the 
possibility of such damages. The use of the information contained in the manual and 
software described herein is subject to GE Fanuc Automation North America, Inc. 
standard license agreement, which must be executed by the buyer or user before the 
use of such information or software.

Notice

GE Fanuc Automation North America, Inc. reserves the right to make improvements 
to the product described in this publication at any time and without notice.

© 1999, 2000, 2001, 2002 GE Fanuc Automation North America, Inc. All rights 
reserved. CIMPLICITY is a registered trademark of GE Fanuc Automation. Any other 
trademarks referenced herein are used solely for purposes of identifying 
compatibility with the products of GE Fanuc Automation North America, Inc.

We want to hear from you. If you have any comments, questions, or suggestions 
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1
Getting Started GFK-1868D

1 Welcome
Congratulations on your purchase of a CIMPLICITY® Machine Edition product. This 
package provides all the tools necessary to create powerful control and HMI 
applications for a variety of run-time targets; a truly scalable solution. Machine 
Edition provides the following features:
■ A fully-integrated environment. Every tool and editor works with the others.
■ Logic Developer - PC, a scalable, computer based control software that includes 

a complete set of IEC standard editors (available with Control Station products).
■ Logic Developer - PLC, a software tool for programming the full line of GE Fanuc 

PLCs (See GFK-1918 Getting Started Logic Developer - PLC).
■ View, a complete system for creating HMIs (human machine interfaces) for 

Windows NT, Windows CE, and QuickPanel units.
■ Motion Developer, for developing Whedco motion control applications.
■ Web Access features that access real-time HMI data any time, from anywhere.
■ Local Manager, a version control, security and audit trail system for your 

automation and control development process.

ControlStation NT/CE Motion Controllers

Machine Edition Environment

Web Access

Build & Download
Runtime Files

ViewStation CE

(Development Tools)
Build & Download

Runtime Files
Build & Download

Runtime Files

Internet/Intranet
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Runtime Files
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Remote I/O

Local
Manager View

Build & Download
Runtime Files

Logic
Developer

PC

Logic
Developer

PLC

Motion
Developer

I/O Modules

QuickPanel



W e l c o m e

System Requirements1
S Y S T E M  R E Q U I R E M E N T S
To use Machine Edition and its tools, you require the following:

Deve lopment  Env i ronment ■ Windows® NT version 4.0 with service pack 6 or later OR

Windows 2000 Professional OR

Windows XP OR

Windows 98 SE.
■ Internet Explorer version 5.5 Service Pack 1 or later.
■ 200 MHz Pentium-based workstation (300 MHz on Windows 2000 or XP).
■ 128 MB RAM minimum.
■ 110-310 MB hard disk space, depending on the selected products.
■ 200 MB hard disk space for sample projects (optional).
■ Additional hard disk space for projects and temporary files.

Windows ® NT  Runt ime ■ Windows® NT version 4.0 with service pack 4 or later OR

Windows 2000 Professional OR

Windows XP.
■ 200 MHz Pentium-based workstation (300 MHz on Windows 2000 or XP).
■ 64 MB RAM.
■ 200 MB free hard disk space.

HRT Runt ime ■ Windows® NT version 4.0 with service pack 4 or later.
■ VentureCom RTX version 4.3 or 5.0.
■ 200 MHz Pentium-based workstation .
■ 64 MB RAM .
■ 200 MB free hard disk space.

Windows ® CE  Runt ime ■ For HMI and Logic components: GE Fanuc ControlStation CE, ControlStation 
CE II, or ControlStation CE IIx.

■ For HMI only: GE Fanuc ViewStation CE, ViewStation CE II, or ViewStation CE 
IIx.
2 Getting Started GFK-1868D



W e l c o m e
Installation
I N S T A L L A T I O N
For last-minute information, release notes, and supported hardware lists for 
Machine Edition products, see the Important Product Information (IPI) document 
on the CD. There are several ways to view this document

■ When installing Machine Edition, select IPI for Machine Edition on the initial 
Launcher screen.

■ When running Machine Edition, click the InfoView tab in the Navigator, then 
double-click the Important Product Information page under Getting Started in 
the Table of Contents.

■ When running Machine Edition, click the Home button on the InfoViewer 
toolbar, then click the What’s New link under Get Started on the left hand side.

To  i n s t a l l  Ma c h i n e  E d i t i o n  f r o m a  CD
1. Insert the CIMPLICITY Machine Edition CD into your CD-ROM drive. 

Windows will automatically start the setup program. If the setup program does not 
automatically start, run Setup.exe in the root directory of the CD.

2. Click Install to start the install process.

3. Follow the instructions as they appear on the screen.
Getting Started 3GFK-1868D



W e l c o m e

Product Authorization1
P R O D U C T  A U T H O R I Z A T I O N
Before you can start developing projects in Machine Edition, you must authorize 
the software with a program called Product Authorization. If you don’t authorize 
the software, you will only be able to use it for a four-day trial period. This 
procedure will take only a few moments and will allow you to take advantage of 
any product support for which you qualify. You will need to contact us by 
telephone, fax, or e-mail as part of the authorization process.

To  a u t h o r i z e  a  c o py  o f  Ma ch i n e  E d i t i o n
1. Have your serial number(s) ready. The serial numbers can be found on the License Key sheet that came with your 

product. 

2. Run the Product Authorization program from the Start menu/Programs/CIMPLICITY Machine Edition/Product 
Authorization. 

The Product Authorization dialog box appears.

3. Click Software, and then click Add.

4. Select the medium with which you are authorizing: Internet, Phone/Fax/E-mail or Floppy Disk Transfer. Click Next.

If you choose the Internet option, proceed to step 5.

If you choose the Phone/ Fax/ Email option, proceed to step 5.

If you choose the Floppy Disk Transfer option, ensure you have an authorization 
disk to proceed. 

5. Fill in the fields in the dialog box. Fields that are identified with an asterisk (*) must be filled in. 

If authorizing online click Submit Authorization once the form is completed.

If authorizing via phone/fax, click the Phone/Fax button once the form is 
completed and call the number on the screen to receive a new key code(s).

If authorizing via e-mail, click the Send E-mail button once the form is complete.

■ Phone. Phone the number listed on the screen to receive a new key code(s).

■ Fax. Click Print FAX and fax the Product Authorization Request to us (our fax 
number will be on the print out). We will then reply by fax with your new key 
code(s).

■ Internet. From the Authorization web page, click Submit Authorization. We 
will then reply by e-mail with your new key code(s).

■ E-mail. Click Authorize to e-mail us. We will then reply by e-mail with your 
new key code(s).
4 Getting Started GFK-1868D



W e l c o m e
Product Authorization
Product Authorization is complete once you enter the new key code and it has 
been accepted. Depending on the product you have purchased, you may need to 
run the Product Authorization program a number of times. For example, if you 
bought ControlStation NT, you will need to authorize both Runtime and 
Development. 

T o  mo ve  th e  a u t ho r i z a t i o n  t o  a no t he r  c om p u t e r
You can run the software only on the computer that the Product Authorization was 
run on. If you want to develop your projects on a different computer, you will need 
to complete the following steps to move the authorization from one computer to 
another.

1. Install Machine Edition on the computer that the authorization will be moved to. Run the Product Authorization 
program from the Start menu/Programs/CIMPLICITY Machine Edition/Product Authorization.
The Product Authorization dialog box appears.

2. Click Move and then click OK. 
There is a Target Site Code on the top right hand side of the screen. Write down 
this site code carefully. It must be accurate for the move to work. You will need the 
Target Site Code when you move the authorized software from the source 
computer. 

3. Click Authorize by disk. 
At this point, you need to go to the source computer that has the authorized 
software, and move the authorization to a disk. 

4. From the source computer, run the Product Authorization program.

5. Click Move, and then click OK. Enter the Target Site Code that you wrote down from Step 3 and click Next. Verify that 
the site code is correct and click OK.

6. Insert a blank formatted floppy disk into the floppy drive and click Next. The authorization code will be moved to 
the disk and a dialog box should appear telling you it was successful. Click OK.

7. Go back to the computer to which you are moving the authorization and insert the floppy disk. (The screen that is 
asking for an authorization disk should be displayed.) Click Next.

8. Click Finish. A screen should appear telling you the move was successful. Click OK.
The authorization has now been moved to the new computer.
Getting Started 5GFK-1868D



W e l c o m e

Technical Support1
T E C H N I C A L  S U P P O R T
Support is available to registered users at no charge for 90 days after purchase. A 
Support and Free Enhancements (SaFE) subscription can be purchased from your 
local GE Fanuc distributor if extended support is required.

If problems arise that can’t be solved using the information in your product 
manual, online Help system, or the GE Fanuc Technical Advisor knowledge base, 
contact us by telephone, fax, or mail.

When contacting us, call from a telephone near your computer and have your 
CIMPLICITY Machine Edition software running. Have the following information 
handy to help us assist you as quickly as possible:

■ The serial number from your installation CD case, and the Product name and 
version number from the Help>About dialog box.

■ The brand and model of any hardware in your system.

■ Operating system and version number.

■ The steps you performed prior to the problem occurring.

N o r t h  A m e r i c a
Support Hotline: 1-800-GEFANUC (1-800-433-2682) Fax: (780) 420-2049
Internet: http://www.gefanuc.com Email: support@gefanuc.com
Comments about our manuals and help: doc@gefanuc.com
Mailing Address: GE Fanuc 

2700 Oxford Tower, 10235 - 101 St.
Edmonton, AB, Canada, T5J 3G1

S o u t h  A m e r i c a
Telephone: +58 (261) 760 2862 Fax: +58 (261) 765 0909
Internet: http://www.gefanuc.com  (visit our Portuguese web site at www.gefanuc.com.br) 
E-Mail: luis.wilhelm@gefanuc.com
Mailing Address: GE Fanuc Automation Latin America

Calle 120 con Av. 17, Los Haticos -GE Turbimeca
Maracaibo, Venezuela

E u r o p e
Internet: For up-to-date contact information, visit www.gefanuc-europe.com and click on “Offices and Services”.

For up-to-date technical information visit www.gefanuc.com/support.
E-mail: plc_europe@gefanuceur.ge.com 
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2 Machine Edition
Machine Edition offers you a complete solution for the development of automation 
applications under one roof. With Machine Edition’s integrated development 
environment and tools, you’ll spend more time building applications and less time 
learning the software.

Machine Edition products are fully integrated with the environment and with each 
other:

■ They share the same project database. No more wasted time synchronizing data 
points between applications!

■ They share the same set of tools, providing a consistent user interface 
throughout the development process.

■ They feature full drag-and-drop capabilities between tools and editors.

■ They feature a true scalable solution. You have the choice of what type of 
machine your projects are downloaded to and run on.

The first part of this chapter provides an overview of the Machine Edition 
Environment. The second part provides some key Machine Edition concepts you 
need to know before you begin. The third part shows how to open and explore 
some of the sample projects included with a new Machine Edition installation. 
When you’ve finished, you’ll have a solid foundation for building your own 
automation projects.

■ For more help getting started, see the Tutorials in the online help (look in the 
InfoView tab of the Navigator).
Getting Started 7GFK-1868D



M a c h i n e  E d i t i o n

Quick Start

8

2

Q U I C K  S T A R T
Machine Edition makes it easy to get started developing a project.

T o  s t a r t  Ma ch i ne  Ed i t i o n
1. Click Start, point to Programs, then CIMPLICITY Machine Edition and then click CIMPLICITY Machine Edition. 

(See also page 23.)

After Machine Edition initializes, the Environment Themes dialog box appears.

Note: The Environment Themes dialog box appears only the first time you start 
Machine Edition.

2. Choose the environment theme you want to work in.

3. Click OK.

When you open a project the appearance of your Machine Edition screen will 
match the preview in the Environment Themes dialog box. As you work you will 
probably modify the environment, open and close windows, change the selected 
toolbars and so on. Any changes you make will be retained in your default 
environment setup.
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Quick Start
The CIMPLICITY Machine Edition dialog box appears.

4. Select the appropriate option to open a project. The Open an existing project option is selected by default.

Notes:

■ If you select either the Empty project option or the Machine Edition template 
option, the New Project dialog box appears to let you create a new project.

■ If you select the Open an existing project option, you can also choose from 
Recent Projects or All Projects. Recent Projects is selected by default.

5. If you selected the Open an existing project option, select the project that you want to open from the list.

Existing projects include samples and tutorials that you can open and use to 
familiarize yourself with Machine Edition.

6. If desired, select the Don’t show this dialog box on startup option.

7. Click OK.

Your project opens in the Machine Edition environment that you specified in the 
Environment Themes dialog box. See also, Machine Edition Projects page 23.

Select this option to work on an
existing project

Select this option to select from
those projects that have been

used recently.

Select this option if you do not want
to see this dialog box again.

Select this option to create a new, 
empty project.

Select this option to create a new 
project based on a Machine Edition 
project template.

Select this option to select from all 
existing projects
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The Machine Edition Environment2
T H E  M A C H I N E  E D I T I O N  E N V I R O N M E N T
All Machine Edition tools and editors appear in the Machine Edition window. The 
Run-time programs are separate Windows applications, so that you can run a 
finished application without starting Machine Edition.

The following illustration shows a possible layout of the tools and a couple of the 
editors available to you. Most of the time, you’ll be using only a few of these at 
once—you can open and close tools and editors as you need them. Many tools are 
also available only when editing a project. We’ll look at some of the tools in the 
following section; for more details on the others, see the online Help.

Inspector:
displays the properties

of a selected object.

Companion:
a dynamic help window

that provides
information based on

what you’re doing.

InfoViewer: 
an embedded 
browser used to 
display reports and 
comprehensive help.

Feedback 
Zone: displays 
output information 
generated by 
Machine Edition 
components.

Editor window:
one of many windows

where you create and edit
your application.

 Data Watch: 
displays the current status 
of your project’s variables.

Navigator:
organizes and displays
project information in

a tree structure.

Toolchest: 
contains 
preconfigured objects 
that can be dragged 
into Machine Edition 
projects.

Common Machine Edition Tools

Navigator tabs:
conveniently layers

information about your
projects.

Editor window tabs:
lets you switch between open editors

with the click of a mouse.
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Getting to Know Machine Edition
G E T T I N G  T O  K N O W  M A C H I N E  E D I T I O N
The following are some key features of the Machine Edition environment. Learning 
about them will make your first few hours with Machine Edition a breeze.

R i g h t - c l i c k ,  r i g h t - c l i c k ,  r i g h t - c l i c k

No matter what object appears on your screen while using Machine Edition, you 
can right-click it to perform operations on it. In fact, this is probably the most 
common way you’ll get things done. Machine Edition tailors the list of commands 
depending on the current status of your project.

G e t t i n g  H e l p

There are many ways to access the Machine Edition online help system. 

■ Press F1 on any selected item for context-sensitive help.

■ Browse through the table of contents in the InfoView tab of the Navigator. 

■ Search for keywords using the index: on the Help menu, select Index.

■ Use the Companion to dynamically display a brief description about 
whatever item you have selected.

You can also access additional help on the web. In Machine Edition on the Help 
menu, point to GE Fanuc on the Web, and then choose:

■ Technical Advisor.

■ GE Fanuc Home Page.
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Getting to Know Machine Edition2
Machine Edition provides two kinds of Help windows to display help information: 
the Companion and the InfoViewer.

Compan ion The Companion window displays brief information about whatever item you 
happen to be working with, anywhere in Machine Edition. Whether you need the 
meaning of a property, the purpose of a node in the Navigator, or an explanation of 
errors generated during validation, the Companion is always there for you. 

By default, the Companion is open while editing projects. If it’s been turned off, 
click on the Tools toolbar to open it again.

I n f oViewer The InfoViewer window is an embedded HTML browser that provides more 
detailed and procedural help. It is launched whenever you access help topics from 
the InfoView Tab, the help index, or by pressing F1 on a selected item.

Want to know more? In the Help Index, look up Help and choose “Finding information in the 
Help”.

Getting Help

Click this button to 
open the InfoViewer 
with more detailed 
information on the 
topic in the Companion.

The InfoView Tab
contains the table of

contents for the online
help. Double-click a

page to view it.

To access the online
Help index, on the
Help menu, choose

Index.

For detailed context-sensitive help, select any item (in this 
case, a button on a graphical panel) and press F1.

The InfoViewer 
window is a browser 
that displays the 
comprehensive HTML-
based online help.

The Companion is a
dynamic help window
that displays snippets

of information on
any selected item.

Use the InfoViewer 
toolbar to navigate 
the HTML help.
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Getting to Know Machine Edition
A c c e s s i n g  t h e  R i g h t  T o o l

Often, Machine Edition Help will direct you to a specific tool window. If the tool 
isn’t visible, there are two ways to open it:

■ On the Tools menu, choose the tool’s name.

■ On the Tools toolbar, click the tool’s icon. To display the Tools toolbar, on the 
Tools menu, choose Toolbars and select the Tools check box.

If you are not sure of the name of a tool within a toolbar, hover the mouse pointer 
over the tool’s button to display its name in a tool tip.

Want to know more? In the Help Index, look up “Toolbars: an Overview”.

InfoViewer

Companion

Toolchest

Inspector

Feedback Zone

Control I/O

Data Watch

Tools Toolbar

Navigator
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Getting to Know Machine Edition2
P r o j e c t s  a n d  t h e  N a v i g a t o r

Nav igato r The Navigator window organizes and manages your projects.

■ Use the Navigator to create and manage projects, add targets and components 
to your project, set your environment preferences, create scripts, open editors, 
create variables, and more.

■ The Navigator is organized into several tabs. The available tabs depend on 
which Machine Edition products are installed and whether a Machine Edition 
project is open. For example, the Project and Variables tabs only appear if a 
Machine Edition project is open.

■ Within each tab, items are displayed in a tree of nodes or folders. You can 
expand and collapse the tree, just like folders in Windows Explorer™.

The following picture illustrates the Navigator prior to any projects being opened. 
All the files listed under My Computer are projects that you have access to on your 
computer. The Samples folder contains sample projects and tutorials.

Want to know more? In the Help Index, look up Navigator and choose “Navigator tool 
window”.

The Manager tab lists all the
projects located on your hard drive
and (if you’re using Manager) the

Manager Server. Use it to create and
open projects, and to manage

projects on an Manager Server.

To add a new project, right-click on 
My Computer and select New.

or

Select Restore to add an existing or 
backed-up Machine Edition project to 
your computer. 

A Machine Edition project must be 
backed up before it can be moved to 
another computer. To do this, right-click 
on a project listed under My Computer 
and choose Back Up.

The InfoView tab contains the 
table of contents for the help.

The Utilities tab contains useful
tools for working on your projects.
Available utilities depend on which

Machine Edition products are
installed.

Navigator Window with Local Project List
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M a c h i n e  E d i t i o n
Getting to Know Machine Edition
T o  ope n  a  p r o j e c t  i n  t he  Nav i ga t o r
1. In the  Manager tab of the Navigator, right-click an existing project listed under  My Computer and choose 

Open.
The project is opened in Machine Edition. The Variables and Project tabs are 
added to the Navigator and the nodes change to reflect those components that 
make up the project you just opened.

The Options tab contains option and
preference settings for the Machine

Edition environment.

The Variables tab contains all the variables 
in your project. Use it to add, delete, move, 
and otherwise manipulate variables.

The Project tab organizes your project. Use it
to navigate around your project, and add,

delete, and configure the items that make up
your project.

These nodes represent the 
different parts of your project. 
They appear when you add 
components to a target.

For example, the Control I/O 
Drivers, Ladder_Program, Logic 
and SFC folders appeared when a 
Logic component was added to 
Target1.

Navigator Window with an Open Project

Targets are the computers that your finished
project will run on. A project can have

multiple targets.
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Getting to Know Machine Edition2
P r o p e r t i e s  a n d  t h e  I n s p e c t o r

 I nspec tor In Machine Edition, practically every object has properties. Properties are simply 
attributes and information about that object. For example, the properties of a box 
on an HMI graphical panel include Height, Width, Fill Color, and Outline Color.

The properties of an object are edited in the Inspector window:

■ To edit an object’s properties, select it with the Inspector open. The Inspector 
will show all those properties associated with the selected object.

■ When a property changes an object’s appearance, you’ll see the results of the 
change immediately in the object’s editor. 

■ To see more properties for an object, select a tab at the bottom of the Inspector.

As you select the various properties within the Inspector, the Companion will 
display a brief description of the selected property.

Want to know more? In the Help Index, look up Inspector and choose “Inspector Window”.

Properties are organized
much like Windows folders.

Click + to expand
the list of subproperties.

Click - to collapse
the list of subproperties.

This is the kind of
object you selected.

To edit this property, click 
the  button.

To edit this property, type
the new value in the box.

To edit this property, select the 
new value from the list box.

If you’re ever unsure of the valid range for a property, 
hover the mouse over its current value and look at the 
status bar at the bottom of the Machine Edition window.

Select a tab for more 
properties.

Inspector Window
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Getting to Know Machine Edition
D a t a  W a t c h  L i s t s

The Data Watch (only available while editing a project) is a debugging tool that 
lets you monitor and edit the real-time values of variables defined in your project. 
This is useful while working online with a runtime target. With the Data Watch tool 
you can monitor individual variables or user-defined lists of variables. You can 
change variable values and force the state of discrete (BOOL) variables. Watch lists 
can be imported, exported, or saved with a project.

There are three tabs in the Data Watch tool: 

■ The Static tab shows variables added to the Data Watch tool.

■ The Auto tab contains variables selected in the variable list or associated with 
the currently-selected instruction in ladder logic. 

■ The Watch List tab contains all variables in the currently selected watch list. A 
watch list lets you create and save a separate list of variables to monitor. You 
can define more than one watch list, but only one watch list can be monitored 
in the Data Watch tool at a time. 

To  d e f i n e  a  Wa t c h  L i s t :
1. Right-click the Data Watch Lists folder and select New.

2. Double-click the new Watch List to open it in the Data Watch tool.

3. Add variables to the Data Watch as desired.
The changes to the watch list are automatically saved for later use.

Want to know more? In the Help Index, choose “Data Watch List”.

Navigator: Project tab

Data Watch nodes

A Watch_List tab contains all variables in your 
project which have been added to the currently-
selected Watch list.

The Static tab contains 
variables that you add to the 
Data Watch tool. 

The Auto tab displays variables 
associated with the item currently 
selected in an editor or tool.

The structure variable 
Robot1 has been expanded 
to show all of its elements. 

Double-click a value to change it.

The IEC or Reference address of 
variables mapped to I/O terminals or 
PLC memory.

The name and value of each element 
of the structure variable Robot1 is 
shown here, even when not 
expanded.

Data Watch Window
Getting Started 17GFK-1868D



M a c h i n e  E d i t i o n

Getting to Know Machine Edition2
S m a r t  L i s t s

While working in Machine Edition editors, you are frequently required to input 
variable names, instruction mnemonics and other data items. In many cases, when 
text entry is required, a Smart List will appear to speed your progress.

As you type in the input box, the list selection 
jumps to the item that is closest to what you 
typed. Press ENTER to create a new item based 
on what is typed, or use the Down arrow to 
use the selected item.

For example, if you typed “fill” in the Smart 
List, the FillLevel variable would be 
highlighted. If you want to use an existing 
variable (in this case, “FillLevel”), use the 
Down arrow to select the highlighted item, 
then press ENTER. To create a new variable 
called “fill”, simply press ENTER without using 
the Down arrow.

This text changes color based on
whether the entry is valid or invalid.

For example, invalid entries are red.
Valid entries in the list are black.

Valid typed entries that are not in the
list appear green; accepting this
entry creates a new item (in this

case, a new variable).

This tells you what you need to enter or select.

Smart List Display
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T h e  T o o l c h e s t

 Too l ches t The Toolchest (only available while editing a project) is a repository of 
preconfigured object templates you can drag into your project. These objects can 
be as simple as a single ladder logic instruction, or as complex as a robotic arm 
with fully-configured ladder logic and HMI animation.

While Machine Edition comes with a set of preconfigured object templates, you 
can create your own—and since you can add as many copies of them as you want, 
this can save you hours of development time.

Definitions of all preconfigured objects within the Toolchest are displayed in the 
Companion.

Want to know more? In the Help Index, look up toolchest and choose “Toolchest”.

Within a drawer, Toolchest items
are organized into folders. You can drag these logic 

instructions directly into 
your ladder program.

The Ladder, HMI, and SFC 
drawers contain simple 
instructions and functions.

Other drawers contain 
fxClasses—definitions for 
fully-configured objects 
that you can also drag into 
your project.

Toolchest items are grouped 
into drawers. Select the drawer 
you want with this list box.

Toolchest Window
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T h e  F e e d b a c k  Z o n e

 Feedba ck  Zone The Feedback Zone (only available while editing a project) is an interactive 
window that displays output information generated by Machine Edition-enabled 
components. Using the Feedback Zone, you can keep track of project information, 
locate validity errors within your project, display generated reports, and more. It is 
organized into several tabs. Click on a message to display more information about 
the error in the Companion Window.

Want to know more? In the Help Index, look up Feedback and choose “Feedback Zone Tool 
Window”.

Feedback Zone

The Build tab displays the status and
results of a validate or download

operation. Use this tab to discover and fix
any errors you may have in your project.

The References tab displays a list of all the places a variable is used in a project. 
To do so, click the Reference tab and then select a variable from the Variable List. 
You will see a list of all the places the variable is referenced in your project.

The Reports tab displays a list of all reports 
generated during the current session. Double-click 
a report in the list to redisplay it in the InfoViewer.

The Messages tab tracks and displays operations that
have been completed within Machine Edition (eg., a

message is added everytime you open a project).

Press F4 to cycle through
entries in the Feedback Zone.

In the Build Tab (shown),
Reports Tab, and References
Tab, pressing F4 also jumps

you to the location of the
selected item in the project.

The Import tab displays a list of errors and warnings
from an import operation (eg., errors/warnings will

be listed when you import variables from a PLC into a
Machine Edition project).
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M a n a g i n g  V a r i a b l e s

Variables are named storage spaces for data values defined in Machine Edition 
projects. A variable could store the current velocity of a motion controller motor, 
the height of a robotic arm, or any other value that an application needs to keep 
track of. Most variables in a project can be shared among various components and 
targets, such as View panels and Logic Developer - PC’s ladder logic.

You manage variables in the Variables tab of the Navigator, also called the 
Variable List. Like most items in Machine Edition, you configure variables by 
editing their properties in the Inspector.

The values a variable can store depends on its data type. For example, a DINT data 
type indicates that the variable can store “Double Integers”, 32-bit values. The 
location where a variable’s value is stored is indicated by its data source. Typically, 
a variable’s value is either stored internally in the target’s memory or is retrieved 
(and sent) to external PLC hardware, via an I/O terminal or other connection. 
Available data types and data sources depend on the target type and (if applicable) 
components added to the target.

Proper ty  Co l umns In addition to the Inspector, the three buttons at the top of the Navigator let you 
edit variable properties in a spreadsheet-like column view.

When opened, the Navigator’s property columns view consists of a grid of cells:

Click to open and close the property column display. This button is only available in the Variables tab.

Click to dock and undock the Navigator window. Undocking the Navigator (that is, making it work like
an Editor window) can make it easier to work with properties in the column view.

Click to display a list of available property columns. Double-click a property to add it to the current set.

This black box indicates that the column
supports “incremental dragging”. Click and
drag the box downwards to fill in the cells

underneath with consecutive values, based
on the value of the starting cell.

Cells for properties that don’t apply to an
item are grayed out.

This grey box indicates the item whose
property you are editing.

The Navigator’s Property Columns view
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Var i ab l e  Repor t s While you can generate reports on many things in Machine Edition, they are 
especially useful for the Variable List. Among the available reports are:

■ All variables by name, filtered or unfiltered.

■ Cross-references to variables (that is, the places they are used in the project).

■ All forced variables (Logic Developer - PC only).

■ Unused variables (that is, variables with no references anywhere in the project). 
The unused variables report also has a link that lets you delete all unused 
variables from the project at once.

Reports are displayed as HTML pages in the InfoViewer. To generate a report, click 
anywhere in the Variables tab then, on the File menu, select Report.

Want to know more about Variables? Look up the following in the Help Index.
■ For information on variables in general, choose “Variables: an Overview”.
■ For information on variables in View, choose “Variables in View”.
■ For information on variables in QuickPanel projects, choose “Variable support in 

QuickPanel applications”.
■ For information on variables in Logic Developer - PC, choose “Variables in Logic 

Developer - PC”.
■ For information on variables in Logic Developer - PLC, choose “Variable support for GE 

Fanuc PLC targets”.
■ For information on variables in Motion Developer, choose “Variables in Motion 

Developer”.
■ For information on importing variables from other applications or database fi les, choose 

one of the “Importing Variables...” topics.
22 Getting Started GFK-1868D



M a c h i n e  E d i t i o n
Machine Edition Projects
M A C H I N E  E D I T I O N  P R O J E C T S
During development, your automation application is called a project. Each 
Machine Edition project is made up of targets and (sometimes) components. A 
target is the hardware platform where the finished project runs, such as a Windows 
NT computer, a ControlStation/ViewStation CE box, a motion controller, or a 
QuickPanel unit. Different Machine Edition products support different target types. 
Targets are often further subdivided into models, such as the ViewStation and 
ControlStation versions of CE targets. Components add specific capabilities to a 
target. Available components depend on the target type, model, and what Machine 
Edition products you have installed.

For example, View lets you add an HMI component to NT and CE targets, used for 
creating human-machine interfaces. Logic Developer - PC lets you add a Logic 
component to NT and CE targets. This lets you create ladder logic to make a PC act 
as a Controller. ViewStation CEs do not support logic; therefore you cannot 
download a project that contains logic to a ViewStation CE.

Motion Developer lets you program motion controllers from your PC. Each motion 
device programmed by Motion Developer is represented by a separate Motion 
target. Since motion targets have no additional capabilities, adding additional 
components is not necessary.

R u n n i n g  a  S a m p l e  P r o j e c t  ( V i e w / L o g i c  D e v e l o p e r  -  P C )

If you’re using View or Logic Developer - PC, we’ve provided some sample 
projects that show basic operations of Machine Edition. Take a few minutes to 
complete the following steps and learn the basics of project development in 
Machine Edition.
■ For a more detailed example of creating projects, in the Help Index, look up 

Tutorial and choose one of the topics listed there.

T o  r un  a  s am p l e  p r o j e c t
1. Run CIMPLICITY Machine Edition from the Start menu/Programs/CIMPLICITY Machine Edition.

2. In the Manager tab of the Navigator, double-click one of the sample applications listed under the 
My Computer folder. 

Sample applications include

■ Alarm Trends: an HMI application that demonstrates alarms and charts.

Want to know more? In the Help Index, look up projects and choose “Machine Edition 
Projects: an Overview”.
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■ Animation Features: an HMI application that depicts the various types of 
animation available in View.

■ Brewery: an HMI and logic brewery application that runs on a Windows NT 
target. 

■ Car Wash: an HMI and logic application that runs on a Windows NT target. 
This application is built in an SFC document.

■ ControlStation HMI Features: an HMI and logic application that runs on a 
Windows NT target. This application also shows some web documents.

■ FC2000 Brewery: an HMI and logic brewery application that runs on a 
ControlStation/ViewStation CE. (Projects containing Logic Developer - PC 
cannot be downloaded to a ViewStation, as ViewStation CEs do not support 
logic.)

■ FC2000 Zone Control: an HMI and logic application that runs on a 
ControlStation/ViewStation CE. This application runs a four-zone ventilation 
logic system. It is to be used with the ControlStation/ViewStation CE Tutorial. 
(Projects containing Logic Developer - PC cannot be downloaded to a 
ViewStation, as ViewStation CEs do not support logic.)

■ ST - Lunar Lander: an HMI and logic application that runs on a Windows NT 
target. This project demonstrates the Structured Text (ST) language and its 
interaction with UDFBs (User Defined Function Blocks).

Tutorials include

■ Animation: an HMI application that illustrates and provides details on the 
various animations that you can use in your HMI.

■ AppExec: an HMI application that demonstrates the AppExec Script function.

■ Keystrokes: an HMI application that displays the analog values associated with 
the keys on your keyboard.

■ Logging: an HMI application that demonstrates how to log production data to 
an ASCII text file.

■ Recipes: an HMI application that shows how one would load and modify 
recipes.

■ Scripting: an HMI application that demonstrates some of View Developer’s 
scripting capabilities.

3. Browse through the project in Machine Edition.
Open the project’s graphical panels, ladder logic, and SFCs (if they exist) in their 
respective editors. To open an editor, right-click the appropriate node in the 

Project tab of the Navigator and select Open.
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Also, take a look at the properties of the various nodes and objects. To view an 
object’s properties, open the Inspector window, and then select an object.

4. In the newly opened project, press F9 to validate, download, and run the sample application.
The F9 key is a shortcut for the Run command which automatically starts View 
Runtime and the Controller.

The sample application should now be running in both View Runtime and the 
Controller. View Runtime appears, displaying the first panel of the project’s HMI. 
You can see the real-time status of the logic by going online to the Controller. For 
information about going online to the Controller, see “To go online to the 
Controller” on page 25.

T o  go  on l i n e  t o  t he  Co n t r o l l e r
If you have chosen a project that contains ladder logic and/or an SFC document, 
you can go online to the application and watch the logic being executed.

1. Minimize the Runtime window (but don’t close it) and return to Machine Edition.

2. In the Project tab of the Navigator, right-click the Target node and choose Go Online.
You are now online to the Controller (that is, you are working with the application 
while it is running). The Controller is the part of the Runtime that solves ladder 
logic and SFCs.

3. In the Project tab of the Navigator, open the Ladder Editor by double-clicking the Ladder Program node or 
open the SFC Editor by double-clicking the SFC node.
In the editor, you can watch the logic being solved as the Controller operates. You 
can start and stop Runtime and the Controller by right-clicking the target, 
pointing to Online Commands, and selecting Start/Stop Runtimes from the 
submenu. To go offline from the Controller, right-click the target and select Go 
Offline.

D e v e l o p i n g  a  M a c h i n e  E d i t i o n  P r o j e c t

The first thing you have to decide when you create a Machine Edition project is 
where the project will run after it is developed. That is, what type of target it will 
have.

For View and Logic Developer - PC, your targets can be a Windows NT computer 
(either the one you’re developing the project on, or a remote one that you connect 
to through a network), or a Windows CE device (a ControlStation/ViewStation CE, 
CE II, or CE IIx).

For View alone, your target can also be a QuickPanel unit.
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For Logic Developer - PLC and Logic Developer - State, your target it a GE Fanuc 
PLC. You can also use remote I/O targets that represent a variety of remote I/O 
adapters.

If you’re using Motion Developer, the choice is easy—simply determine whether 
your motion hardware is a motion controller/drive or a drive-only device (see page 
85). 
After you’ve decided on the target, you need to determine which components your 
project will include: HMI (with View), and/or Logic (with Logic Developer - PC). 
Note that ViewStation does not support Logic components. A project can have 
multiple targets of different types with various components running on each target.

To  c r e a t e  a nd  d eve l o p  a  p r o j e c t
The following procedure introduces the general steps involved in creating a 
project using a template, and downloading a project to a target computer.

1. Start CIMPLICITY Machine Edition from the Start menu/Programs/CIMPLICITY Machine Edition.

2. Create a project using a template.
In the Manager tab of the Navigator, right-click My Computer (if using 
Manager—right-click Machine Edition) and select New. The New Project dialog 
box appears.

3. In the New Project dialog box, type a name for the new project, select a template, and click OK. 
A description of the template appears below your selection. You can click 
hypertext links in the description for details on the template components.

At this point, you need to know what type of target your project will download to 
as this will determine which template you choose.

The project is opened in Machine Edition and the Navigator changes to reflect 
those components that make up the project you just created.

4. In the Variable List, create variables for your application.
In the Variables tab of the Navigator, right-click the Variable List node, point to 
New Variable, and choose the type of variable you want to create.
By default, the Variable List node filters out all system variables. System 
variables are created automatically when you add components to Windows NT, 

Want to know more? In the Help Index, look up “Targets: an Overview”.

Want to know more? In the Help Index, look up templates and choose “Creating a New 
Machine Edition Project” or “Creating a Project with CIMPLICITY Manager”.
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CE , QuickPanel or PLC targets. To display all variables including system variables, 
right-click the Variable List node, point to Filter By, and choose No Filter.

5. Create your application.
With Logic Developer - PC, add logic (Ladder, Il, ST, SFC) to your project and 
configure a control I/O driver to model you equipment. If the template you chose 
did not include a Logic component, add one now—right-click the target, select 
Add Component, and choose Logic. (ViewStation doesn’t support logic.)

■ In the Project tab of the Navigator, under the Logic folder, open the Ladder 
Editor by double-clicking the Ladder Program node.

■ Drag ladder instructions from the  Toolchest into the editor. You can find 
ladder instructions in the Ladder drawer of the Toolchest.

■ Assign variables to instructions. You can do this with the Smart List, which 
appears when you insert or double-click an instruction. Or, drag a variable 
from the Variables tab of the Navigator and drop it on the instruction you 
want it mapped to.

■ You can add additional logic blocks (IL, ST) and organize your logic with SFC.

With View, create the graphical panels and animation for your project. If the 
template you chose did not include an HMI component, then add one now—right-
click the target, select Add Component, and choose HMI. (If a target has both an 
HMI and a Logic component, you’ll typically create the Logic component first.)
■ In the Project tab of the Navigator, open the Panel Editor by double-clicking 

a panel node.
■ Use the Graphical Panel toolbar to create your HMI and/or drag graphical 

objects from the Toolchest onto a panel. You can find a set of fully-configured 
objects (complete with animation) in various Toolchest Expert Objects drawers.

With Motion Developer, begin by running the Motion Expert wizard.

■ If necessary, open the “Main Wizard” home page by right-clicking the target 
and selecting Main Wizard.

■ In the wizard page, click Motion Expert and follow the instructions on screen. 
For more information on using wizards, see page 89.

Want to know more? In the Help Index, look up variables and choose “Variables: an 
Overview”.

Want to know more? In the Help Index, look up logic and choose “Ladder Logic Instructions: 
an Overview”.
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6. If necessary, configure the I/O hardware connections for your project.

■ For Logic Developer - PC, Set up Control I/O in the Control I/O Drivers 
folder (in the Project tab of the Navigator). To add a driver, right-click the 
Control I/O Drivers folder and select New Driver. Use the Control I/O Tool to 
configure your drivers. Map variables to I/O terminals.

■ For View, set up PLC Access I/O in the PLC Access Drivers folder. To add a 
driver, right-click the PLC Access Drivers folder and select New Driver. 
Configure the drivers in the Inspector window. On NT targets, you might want 
to set up OPC I/O in the OPC Client folder.

7. When your project is complete; validate, download, and run your project by pressing the F9 function key.
Machine Edition saves the project, performs a validation, builds the Runtime files, 
and attempts to establish a connection to the target computer.

V a l i d a t i n g  a n d  D o w n l o a d i n g  a  P r o j e c t

During project development, you will go through the validation and download 
processes several times. The validation process checks the project for errors. If the 
project contains errors, they are listed in the Build tab of the Feedback Zone.

■ All errors must be fixed before the download process can proceed. Warnings 
are also listed in the Feedback Zone, but they do not prevent the download 
from starting.

When fixing project errors, use the F4 function key to scroll through errors in the 
Feedback Zone, jumping to their locations in the project. 

The download process involves two steps. The first step creates (or builds) all the 
runtime files necessary for a target to perform its role in a completed project. The 
second downloads those files to the target devices or computers.

■ For Motion Developer, the easiest way to set up the motion control device for 
downloading is with the Set Communication Parameters wizard. Open the 
Main Wizard page for the target (right-click the target and select Main Wizard). 
Then, point to Configuration and select Communication Parameters. Click 
Finish when you’re done.

■ To download a View or Logic Developer - PC project to the Windows NT 
computer on which you are developing (a local target), ensure the target 
property Computer Address is set to “.” (without the quotation marks). 
Otherwise—for remote targets—type the IP address or computer name of the 
remote computer you want to download to, in the Computer Address property.

Want to know more? In the Help Index, look up control and choose “Control I/O Tool”.
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■ To download a QuickPanel project, ensure the target property Computer 
Download Port is set to the applicable COM port.

Additional basic information on setting up Windows NT and CE targets follows.

Pr epa r i n g  a  Remo t e  NT  ta r g e t  f o r  D own l o ad i n g
The following steps need to be completed on the remote Windows NT target 
computer before you can download a project to it. 

1. If you are downloading to another NT computer (other than the ControlStation or CE box), ensure that the runtime 
files are installed on that device.
ViewStation and ControlStation targets are shipped with the runtime files 
preinstalled. If you’re using your own Windows NT computer, you’ll have to install 
the runtime files yourself.

2. Share the Machine Edition installation directory with the development computer that contains the project files.
In the Windows NT Explorer, navigate to the Machine Edition folder, right-click on 
it and select Sharing. Click Shared As and in the Share Name field, type Machine 
Edition.

3. Ensure you have the proper permissions to download files to the target computer.
Start the Windows NT User Manager (from the Taskbar, click Start, point to 
Programs, Administrative Tools, and select User Manager). Double-click the Guest 
user in the top half of the display. Clear the Account Disabled check box.

4. Within your Machine Edition project, specify the IP address or computer name of the remote NT target in the 
Computer Address target property. This allows Machine Edition to locate and connect to the NT target computer. 

Want to know more? In the Help Index, look up downloading and choose “Preparing 
Windows NT Targets for Downloading”.

Type the IP address or the computer 
name of the remote NT target to which 
you want to download your project files.
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Pr epa r i n g  a  W i n dows  C E  T a r g e t  f o r  d o wn l oa d i ng
The following steps need to be completed on the ControlStation/ViewStation CE II, 
IIx before you can download a project to it. If you are not physically connected to 
a ControlStation/ViewStation CE but want to test your project, you can download 
the project to your local computer by setting the Use Simulator target property to 
True. Note that you cannot download a project that contains a logic component to 
a ViewStation CE, since ViewStation CEs do not support logic.

1. Physically connect the ControlStation/ViewStation CE to the Ethernet network. This step may require the help of a 
network administrator.

2. Within your Machine Edition project, specify the IP address of the ControlStation/ViewStation CE in the Computer 
Address target property.
To find the IP address of a ControlStation/ViewStation CE, double-tap the  
System Information icon located on the desktop of the CE box.

By default, the ControlStation/ViewStation CE uses a DHCP (Dynamic Host 
Configuration Protocol) IP address. This means the IP address is dynamically 
assigned by the Ethernet network server using DHCP. If you want to use a fixed IP 
address, you must manually set the IP address on the ControlStation/ViewStation 
CE. 

Want to know more? In the Help Index, look up downloading and choose “Preparing 
Windows CE Targets for Downloading”.

Type the IP address of the 
ControlStation/ViewStation CE to which 
you want to download your project files.
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T e s t i n g  a  V i e w  P r o j e c t

The following steps introduce you to the Quick Test feature. Quick Test is similar 
to a preview in that it allows you to quickly see the results of any changes you’ve 
made to a graphical panel without having to download your entire project.

Note: The Quick Test feature is not available on QuickPanel targets.

Before you can use Quick Test, your project must have been downloaded at least 
once to the target computer. If you want to Quick Test a graphical panel from a 
ControlStation/ViewStation CE project, you need to set the target’s Use Simulator 
property to True and perform at least one download after changing the setting. 

To  Qu i c k  T e s t  c han ge s  made  to  a  g r aph i c a l  p a n e l
1. Ensure that you’ve downloaded the HMI to the target computer at least once.

2. If you haven’t already done so, open the graphical panel you want to test.

3. Right-click in the panel and select Quick Test. 
View Runtime appears with a preview of the graphical panel.
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3 Logic Developer - PC
Logic Developer - PC is the PC control section of Machine Edition providing the 
logic component of a project. With Logic Developer - PC you create control 
programs using standard IEC 61131-3 editors in a graphical environment. The 
programs you create are downloaded to the PC Logic Controller and executed. 
You interface to a plant or process through the I/O system of your choice; Logic 
Developer - PC supports a wide range of industry standard hardware.

Logic Developer - PC supports Windows NT and CE targets.
All user-defined logic programs are contained in the Logic folder, including 
the following: 
■  Sequential Function Chart (SFC) Editor (see page 35)
■  Ladder Program (see page 39)
■  Instruction List Blocks (see page 43)
■ Structured Text Blocks (see page 46)

The following runtime elements are included with Logic Developer - PC:
■  Control I/O Drivers (see page 49)
■  PC Logic Controller (on target computer) (see page 52)

Note: User-defined folders can be added to the Logic folder or to another user-
defined folder to organize your logic. A user-defined folder can contain any type of 
logic block except ladder, of which there is only one, contained by the logic 
folder.

Navigator: Project tab

Logic component nodes
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T o  c r e a t e  a  p r o j e c t  t ha t  i n c l u d e s  a  l o g i c  c om p on e n t
1. In the Manager tab of the Navigator, right-click My Computer and choose New. 

The New Project dialog box appears.

2. In the Project Name box, enter a name for your project.

3. From the Project Template list, choose a template that includes a logic component.
A preview of what each template includes is displayed as you select different 
templates.

4. Click OK.
Your new project is created and the Project tab is opened in the Navigator.

To  add  a  l o g i c  c ompon en t  t o  a n  ex i s t i n g  p r o j e c t
• In the Project tab of the Navigator, right-click a target, point to Add Component and choose Logic.

The Logic folder with an empty ladder program and SFC component is added to 
your project. 

To  add  a  u s e r - d e f i n ed  f o l d e r  t o  yo u r  p r o j e c t
1. Ensure that your project contains a logic component (see above).

2. Right-click the Logic folder or a user-defined folder, point to New, and then choose Folder.

The new folder appears in the Project tab of the Navigator in alphabetical 
order.

3. (Optional) Enter a name for the new folder.
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S F C  E D I T O R
SFC logic is a graphical language for organizing the sequential execution of 
control logic. The SFC editor is an easy-to-use graphical tool for editing sequential 
function charts in the Machine Edition environment. With the SFC editor, you can 
work on a disk copy of a sequential function chart (offline) or monitor the 
execution of an SFC running in the Controller (online). You can also configure the 
appearance and behavior of the SFC editor.

S e q u e n t i a l  F u n c t i o n  C h a r t

An SFC is much like a flow chart; it is a high level control program that organizes 
detailed blocks of logic into a state-like flow. In general, an SFC consists of steps 
alternating with transitions. Each step represents a state that the program is in until 
the transition following it allows execution to proceed to the next step. Each step 
contains actions that are user-defined sections of ladder, IL, or ST logic. The 
actions in a step are executed in the order they are listed and are repeated each 
Controller scan while the step is active. Each action in a step has a qualifier 
associated with it that governs when and how the action will be executed.

An SFC document is a grid of cells. Each cell can contain an instruction. The 
instruction set includes steps, transitions, branches, parallels and jumps. 

An SFC can be expanded by adding macros. Each macro is a special SFC 
document that can be referenced any number of times from its SFC document or 
other macros.

To  add  a  n e w SF C
1. In the Project tab of the Navigator, right-click the Logic folder or a user-defined folder, point to New, 

and then choose SFC.
The new SFC appears under the Logic folder or a user-defined folder in 
alphabetical order.

2. (Optional) Enter a unique name for the new SFC.

T o  ope n  a n  S FC  o r  m a c r o  f o r  e d i t i ng
• In the Project tab of the Navigator, under the Logic folder or under a user-defined folder, double-click 

an SFC or macro node.
The SFC Editor opens with the document ready for editing.

Want to know more? In the Help Index, look up Macro and choose “SFC Macro”. You can also 
see the SFC Tutorial in the online help (look up SFC in the Help Index). This tutorial takes you, step-
by-step, through the creation of a Sequential Function Chart that controls traffic signals.

Navigator: Project tab

SFC nodes
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T o  c r e a t e  a  n e w SF C  m a c r o
1. In the Project tab of the Navigator, under the Logic folder or under a user-defined folder, right-click an 

SFC or macro node and choose New.

2. (Optional) Enter a unique name for the new macro.
Your new macro appears as a child node of the SFC or macro node you started 
with.

W o r k i n g  w i t h  t h e  S F C  E d i t o r  -  O f f l i n e

The SFC Editor interacts with the Machine Edition tools to provide maximum 
flexibility when editing a program. The following picture illustrates some of the 
operations you can perform.

Use the Variable List
to create variables
then drag them to
instructions in the

SFC Editor.

Configure instructions
and their associated

variables in the
Inspector.

The Companion
provides help on

anything you click.

Insert instructions, 
rows, and columns 
with the SFC toolbar.

Drag instructions from 
the SFC drawer of the 
Toolchest to the SFC 
editor.

Right-click a blank cell 
to start editing.

Call a macro with a
Macro Step instruction.

Locate all instances of 
a variable (References) 
or syntax errors 
(Build).
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To  i n s e r t  a n  SF C  i n s t r u c t i o n
1. In the SFC Editor, right-click a blank cell and choose Place Instruction.

2. Choose an instruction mnemonic from the smart list that appears and press ENTER to finish.
You can set the SFC Editor options to automatically assign default variables to 
instructions or to allow you to choose and create your own.

T o  Q u i c k  E d i t  a n  S FC
• In the SFC Editor, click a blank cell and type instruction mnemonics separated by operators (see the following table). 

Press ENTER to finish.
Each mnemonic specifies one or more instructions. Each operator moves the 
location of the currently selected cell. Default variables are assigned when Quick 
Editing an SFC.

SFC Ope rato rs

To ... Use ...

move right one cell +

move left one cell -
move down one cell ;
stay on current cell /
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W o r k i n g  w i t h  t h e  S F C  E d i t o r  -  O n l i n e

The SFC editor allows you to view the execution of an SFC as it happens. The 
following picture illustrates this capability.

T o  go  on l i n e  t o  t he  Co n t r o l l e r ’ s  S F C
• In the Project tab of the Navigator, right-click the target and choose Go Online. (Before you can go online to 

the Controller, you must first download the project.) 
The Controller’s SFC appears in the SFC Editor. When the Controller is running, 
active steps and transitions are graphically indicated. 

Active steps and
transitions are
highlighted in

bold color.

Right-click any
BOOL to turn or

force it On or Off.

Power flow in the 
associated ladder 
program (actions) is 
indicated in bold color 
while actions are 
executed.

Use the Data Watch to 
monitor or change 
data values in real 
time.

The References tab of the
Feedback Zone lists all
instances of a variable.

Click an entry to locate it
in an editor.

Many actions can be 
viewed at once.
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L A D D E R  E D I T O R
Ladder logic is likely the most popular language in use today for creating control 
programs. The ladder editor is a graphical tool for editing ladder programs in 
Machine Edition. With the ladder editor, you can work on a disk copy of a ladder 
program (offline) or with a live program as it runs in the Controller (online). You 
can also configure the appearance and behavior of the editor under the Options 
tab of the Navigator.

L a d d e r  P r o g r a m

A ladder program is composed of rungs of ladder logic instructions that execute 
sequentially from left to right, top to bottom. The instruction set includes standard 
IEC 61131-3 functions supplemented by a large library of advanced and I/O 
specific functions. Along with rungs and instructions, a ladder program contains:
■  Labels: Each default (START and END) or user-defined label is a rung 

providing an entry point for program execution.
■  Subroutines: Each user-defined subroutine is a separate, reusable 

section of logic that can be called from anywhere in a ladder program.
■  Actions: Each action is a separate block of logic that can be referenced 

in a Sequential Function Chart.
Note: You can also use User-Defined Function Blocks (UDFBs). Each UDFB is a 
callable subroutine that you can pass parameters to/from.

T o  ope n  a  l a d d e r  p r og r am  f o r  e d i t i n g
• In the Project tab of the Navigator, under the Logic folder, double-click the Ladder_Program node.

Your ladder program opens in the Ladder Editor.

T o  l o c a te  a  l a b e l
• In the Project tab of the Navigator, under the Logic folder, under the Ladder Program folder, double-

click a label node.
Your ladder program, subroutine or action opens in a Ladder Editor window with 
the label selected.

Want to know more? In the Help Index, look up ladder and choose “Ladder Program: an 
Overview” or “UDFB”.

Navigator: Project tab

Ladder logic nodes
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Ladder Editor3
T o  c r e a t e  a  n e w  su b rou t i n e  o r  a c t i o n
1. In the Project tab of the Navigator, under the Logic folder, under the Ladder Program folder, right-click 

the Subroutines or Actions node and choose New.

2. (Optional) Enter a unique name for the new subroutine or action.
An empty subroutine or action, labeled with the name you entered, is 
created. Double-click the node to open it for editing. You can add ladder logic to 
the subroutine or action as required.

W o r k i n g  w i t h  t h e  L a d d e r  E d i t o r  -  O f f l i n e

The Ladder Editor interacts with all of the Machine Edition tools to provide 
maximum flexibility when editing a program. The following picture illustrates 
some of the operations you can perform.

T o  i n s e r t  a  r u ng
• In the ladder logic, right-click a rung, shunt, label or description and choose Insert Rung.

An empty rung is inserted. You can set the editing options for the Ladder Editor so 
that rungs are inserted either before or after the current selection.

Drag instructions from 
the Ladder drawer of 
the Toolchest.

The Companion tracks
your moves providing

information on what
you click.

Drag variables to
instruction parameters

to configure them.

Drag branches around
instructions to create

parallel execution
paths.

Insert rungs and 
common instructions 
with the Ladder 
Instruction toolbar.

Click a shunt and type
mnemonics to insert

instruction (QuickEdit).

In-place edit 
descriptions for rungs, 
variables, and your 
ladder program.

Locate all instances of 
a variable (References) 
or syntax errors 
(Build).

Display subroutines
and actions in

separate editor
windows.
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T o  Q u i c k  E d i t  l a d de r  l o g i c
• In the ladder logic, click on a rung and type instruction mnemonics separated by semicolons, and then press ENTER.

The instructions specified by the mnemonic string you entered will be inserted, in 
order, on the rung. You can enter mnemonics followed by variable names if you 
want to assign instruction parameters while Quick Editing.
Example: Add a Normally Open Contact (NO) instruction followed by a Coil 
(OUT) instruction and assign the variables MySwitch and MyCoil to these 
instructions respectively.
NO MySwitch; OUT MyCoil

W o r k i n g  w i t h  t h e  L a d d e r  E d i t o r  -  O n l i n e

With the Ladder Editor you can go online to a ladder program being run by the 
Controller (page 52). While online, you can view the power flow through the 
ladder logic and watch data values change in real time. You can also edit the 
ladder program, just as you would while offline, with the following restrictions:
■ Labels, subroutines, and actions cannot be deleted while online.
■ Only one rung can be changed before writing the changes to the Controller.

The following picture illustrates the Ladder Editor while online to the Controller.

Power flow is indicated
with bold colored lines.

New or edited rungs are
indicated with alternate

color bold lines until
you Write Changes.

Lightning bolts in each 
corner indicate the 
Controller’s status and 
change to reflect fault 
conditions.

Data values are 
displayed in real time 
as they change each 
scan by the Controller.

Use the Data Watch to 
view or set data values 
for any variable in your 
project.

Online status is indicated
by the color of the

target icon.
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Ladder Editor3
To  go  o n l i n e  t o  t he  Co n t r o l l e r ’ s  l a dde r  p r og r am
• In the  Project tab of the Navigator, right-click the  target and choose Go Online. (Before you can go online 

to the Controller, you must first download the project.)
The Controller’s ladder program appears in the Ladder Editor. When the Controller 
is running, power or state flow is graphically indicated and data values updated. 

T o  wr i t e  a  c ha ng ed  r u ng  t o  t h e  Co n t r o l l e r
• From the Controller menu, choose Write Changes. (The Controller menu is available only when the Ladder Editor is 

selected.)
The Controller’s ladder program is updated with the single altered rung.
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Instruction List Editor
I N S T R U C T I O N  L I S T  E D I T O R
IL logic is one of four languages specified by the IEC 61131-3 standard. The IL 
Editor is an easy-to-use, intelligent, free-form text editor for editing IL blocks in the 
Machine Edition environment. With the IL Editor, you can work on a disk copy of 
an instruction list (offline) or monitor the execution of an IL bLock running in the 
Controller (online). You can also configure the appearance and behavior of the 
editor under the Options tab of the Navigator.

I n s t r u c t i o n  L i s t

IL is a low-level language composed of basic and advanced Math instructions that 
execute sequentially from top to bottom. IL blocks can also contain labels 
providing entry points for program execution. In its simplest form an IL can:

1. Load a data value (operand) into the accumulator.

2. Perform an operation on the accumulator, saving the result in the accumulator.

3. Store the accumulator’s value to memory (a variable).

4. Do another accumulator load or operation, etc.

T o  ope n  a n  I L  b l o c k  f o r  e d i t i n g
In the Project tab of the Navigator, under the Logic folder or under a user-
defined folder, double-click an IL block node.
Your IL block opens in the IL Editor.

T o  c r e a t e  a  n e w  I L  b l o c k
1. In the Project tab of the Navigator, right-click the Logic folder or a user-defined folder and choose New.

2. (Optional) Enter a name for the new IL block then press ENTER.

Your new IL block appears as a child node of the Logic folder or a user-defined 
folder.

Note: IL blocks can be executed only when called as Actions from an SFC.

Want to know more? In the Help Index, look up “IL Editor: an Overview”.

Navigator: Project tab

IL block nodes
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Instruction List Editor3
W o r k i n g  w i t h  t h e  I L  E d i t o r  -  O f f l i n e

The IL Editor interacts with the Machine Edition tools to provide maximum 
flexibility when editing a program. The following picture illustrates some of the 
operations you can perform.

T o  i n s e r t  a n  I L  i n s t r u c t i o n
1. In the IL Editor, just begin typing. A smart list will appear containing any items (labels, mnemonics or variables) that 

are applicable at the current cursor position.

2. Enter or choose from the list the mnemonic you want.
To convert a name to a variable, simply right-click the name and point to Create 
“name” as. Choose a data type from the list that appears.

The Companion
tracks your moves

providing
information on
what you click.

Copy and paste an
IL statement(s)

from the IL editor to
other sections or IL

blocks.

Multiple-line block 
comments to 
document your IL 
block.

Drag variables to
the IL Editor to

complete IL
statements.

In-line comments for 
individual IL 
statements. 

Simply begin typing
for a smart list to

appear.

Locate all instances 
of a variable 
(References) or 
(Build).
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W o r k i n g  w i t h  t h e  I L  E d i t o r  -  O n l i n e

The IL editor allows you to view the execution of an IL block as it runs. This is 
illustrated in the following diagram.

T o  go  on l i n e  t o  t he  Co n t r o l l e r ’ s  I L
1. In the Project tab of the Navigator, for each of the following right-click the target and choose:

2. Validate (F7).

3. Download (F8).

4. Run (F9)

5. Go Online (CTRL+F11).
The Controller’s IL block appears in the IL Editor as read-only and with a grey 
background. In the IL Editor, you can monitor the values of a variable, by clicking 
on the variable. You can also change and/or force BOOL variable states.

Variable types and
their data values are

displayed in real
time as they change

each scan by the
Controller.

The grey background 
indicates that the 
editor is online with 
the controller and is 
read-only.

Online status is
indicated by the color

of the target icon.

Use the Data Watch 
tool to view or set 
data values for any 
variable(s) in your 
project.

Right-click any BOOL
variable to force it

On/Off or to turn it
On/Off.
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Structured Text Editor3
S T R U C T U R E D  T E X T  E D I T O R
ST logic is one of four languages specified by the IEC 61131-3 standard. The ST 
Editor is an easy-to-use, intelligent, free-form text editor for editing ST blocks in the 
Machine Edition environment. With the ST Editor, you can work on a disk copy of 
a structured text block (offline) or monitor the execution of an ST bLock running in 
the Controller (online).

S t r u c t u r e d  T e x t

ST is a high-level language composed of basic and advanced Math instructions. ST 
blocks can be executed as Actions called from SFC Steps, or when called as a 
subroutine from other ST blocks or ladder programs.

If an ST block is named ’MAIN’, after downloading, the execution of every scan 
will begin the ladder program, then the SFC program(s), then the named ’MAIN’ ST 
block. 

Some of the features in ST are: timers, arrays, bitwise access and User Defined 
Function Blocks (UDFBs). The Return keyword causes an early exit from a 
subroutine. 

Note: Each UDFB is a callable subroutine to and from which you can pass 
parameters.

T o  ope n  a n  S T  b l o c k  f o r  e d i t i n g
In the Project tab of the Navigator, under the Logic folder or under a user-
defined folder, double-click an ST block node.
Your ST block opens in the ST Editor.

T o  c r e a t e  a  n e w ST  b l o c k
1. In the Project tab of the Navigator, right-click the Logic folder or a user-defined folder, point to New, 

and then choose ST Block.

2. (Optional) Enter a name for the new ST block.

Your new ST block appears under the Logic folder or under the user-defined 
folder.

Want to know more? In the Help Index, look up “ST Editor” or “UDFB”.

Navigator: Project tab

ST block nodes
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Structured Text Editor
W o r k i n g  w i t h  t h e  S T  E d i t o r  -  O f f l i n e

The ST Editor interacts with the Machine Edition tools to provide maximum 
flexibility when editing a program. The following picture illustrates some of the 
operations you can perform.

To  i n s e r t  a n  ST  i n s t r u c t i o n
1. In the ST Editor, just begin typing. To obtain a list of valid variables, right-click anywhere and choose Insert 

Variable. Enter or choose a variable from the list that appears.

2. To obtain a list of valid mnemonics, right-click anywhere and choose Insert Keyword. Type or choose a keyword 
from the list that appears, and then press ENTER.

The Companion
tracks your moves

providing
information on what

you click.

Copy and paste ST
statements from the

ST editor to other
sections or ST blocks.

Multiple-line block 
comments to 
document your ST 
block.

Drag variables to the
ST Editor to complete

ST statements.

Hover over a 
variable with the 
mouse cursor to see 
its data type.

Locate all instances 
of a variable 
(References) or 
(Build).

In-line comments for 
individual ST 
statements. 
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Structured Text Editor3
W o r k i n g  w i t h  t h e  S T  E d i t o r  -  O n l i n e

The ST editor allows you to view the execution of an ST block as it runs. This is 
illustrated in the following diagram.

T o  go  on l i n e  t o  t he  Co n t r o l l e r ’ s  S T
1. In the Project tab of the Navigator, for each of the following right-click the target and choose:

2. Validate (F7).

3. Download (F8).

4. Run (F9)

5. Go Online (CTRL+F11).

The Controller’s ST block appears in the ST Editor as read-only and with a grey 
background. In the ST Editor, you can monitor the values of a variable, by clicking 
on the variable. You can also change and/or force BOOL variable states.

The grey background 
indicates that the 
editor is online with 
the controller and is 
read-only.

Online status is
indicated by the color

of the target icon.

Use the Data Watch 
tool to view or set 
data values for any 
variable(s) in your 
project.

Variable types and 
their data values are 
displayed in real 
time as they change 
each scan by the 
Controller.

Right-click any BOOL
variable to force it

On/Off or to turn it
On/Off.
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Control I/O Drivers
C O N T R O L  I / O  D R I V E R S
A control program (SFC, ladder, IL or ST) generally interfaces with the process it is 
controlling through some type of physical I/O equipment. For PC-based control 
systems this usually involves installing an adapter card in the target computer that 
connects to an industry standard I/O network. In this way, data generated by a 
process can be acquired and acted upon by the Controller as it executes its 
program(s). Control I/O drivers provide the software required to connect the 
Controller with an adapter card and the I/O network of your choice.

I / O  D r i v e r s

Logic Developer - PC comes complete with a constantly growing library of drivers. 
Some of these drivers require no additional equipment to be installed on the target 
computer including the following:
■ ASCII: Allows you to use an existing communications port on the target 

computer to send and receive ASCII formatted data to and from other 
equipment.

■ Control Peer: Allows Controllers running on two or more computers to share 
process data. Messages are passed via ethernet when variable values change.

Other drivers require third-party adapters to be installed in the target computer. 
Logic Developer - PC supports most of today’s most popular I/O networks 
including the following:

Want to know more? In the Help Index, look up control and choose “Control I/O Drivers”.

■ Allen-Bradley RIO ■ Interbus-S I/O

■ DeviceNet I/O1

1. Also supported for Windows CE targets

■ Legacy DeviceNet I/O

■ Ethernet I/O1 ■ Legacy PROFIBUS I/O1

■ GE Fanuc CNC I/O ■ Modbus Slave

■ GE Genius I/O ■ Modicon MB + Distributed I/O

■ GE Fanuc Series 90-30 I/O1,2 ■ Modicon Quantum-800 Series I/O

■ Honeywell SDS ■ PROFIBUS I/O1, 2

2. Also supported for the Hard Real-Time Controller

Navigator: Project tab

Control I/O nodes
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Control I/O Drivers3
To  add  a  C on t r o l  I / O  d r i v e r  t o  a  t a r g e t
• Right-click the Control I/O Drivers node, point to New Driver then choose a driver from the list.

The new driver appears as a child node under the Control I/O node. A 
default configuration of the driver is also added to the Control I/O tool. You can 
add up to nine drivers to a target. 

C o n t r o l  I / O  T o o l

Cont ro l  I/O The Control I/O tool is a special editor used to graphically model the I/O 
equipment driven by Control I/O drivers. Each I/O system is portrayed as a tree 
structure starting with a driver node branching down to terminals that 
represent physical field connections. Between the driver and terminals are nodes 
representing any cards, racks or modules included in the system. Field 
data is shared with the components of your project by mapping variables to each 
I/O terminal.

Want to know more? In the Help Index, look up Control I/O Tool and choose “Control I /O 
Tool”.
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Control I/O Drivers
W o r k i n g  w i t h  C o n t r o l  I / O

The Control I/O tool interacts with other Machine Edition tools to speed the 
creation of your I/O system. The following picture illustrates some of the 
operations you can perform.

T o  c on f i g u r e  a n  I/ O  sy s t e m w i t h  t h e  Con t r o l  I/ O  t oo l
1. Right-click a driver, card, rack, or slot and choose Add xxx to build an I/O tree.

2. Double-click a driver, card, rack, or slot node to configure it.

3. Map variables to I/O terminals.

Use the Variable List
to create variables

then drag them to I/O
terminals.

IEC addresses can be 
displayed in a ladder 
program above 
variables mapped to 
I/O terminals.

Drag variables from
the ladder editor to

Control I/O terminals.

Double-click a node to 
configure a driver, 
card, rack or slot.

View and edit data 
values for variables 
mapped to I/O 
terminals.

Double-click a
terminal and type a
name to create and

map a variable of the
default type.
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Controller3
C O N T R O L L E R
The Controller is a Runtime engine, hosted on a target, that performs the 
following operations in a repeated scan cycle:

■ Solves logic in a ladder program, including any called subroutines.

■ Solves logic in an SFC, including any called actions.

■ Solves ST block named ‘MAIN’ (if it exists), including any called subroutines.

■ Interfaces with Control I/O drivers.

■ Updates the target’s runtime database, which is shared with the View Runtime 
(see page 72).

The following diagram illustrates the Controller’s scan cycle.

The Controller can be hosted on a:
■ Windows NT target. The Controller appears as a Logic Developer - PC system 

service.
■ Windows NT target with VenturCom RTX. The Hard Real-time Controller 

appears as a Logic Developer - PC system service.
■ Windows CE target. The Windows CE Controller appears as a Logic Developer 

- PC program running under Windows CE.

Navigator: Project tab

Target node
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Controller
You specify a target when creating a project. The Hard Real-time Controller is a 
special add-on configured only on Windows NT targets. In all cases, the Controller 
automatically starts when the target operating system is started.

W o r k i n g  w i t h  t h e  C o n t r o l l e r

The Controller’s location (IP address or computer name), performance (scan rate or 
tuning), and behavior (response to faults, watchdog timer and shutdown 
procedure) are configured by setting the properties of the target it resides on.

T o  c on f i g u r e  t he  Con t r o l l e r
1. In the Project tab of the Navigator, right-click a target and choose Properties.

2. In the Inspector, adjust the properties.
If your project includes an HMI component, properties of the View Runtime can 
also be set at this time. You can also configure the Controller’s properties by 
selecting Properties from the Controller menu. In this case, the Controller 
Properties dialog box opens. The information in the dialog box is the same as in 
the Inspector—just represented differently.

The logic component of a project must be downloaded to the Controller before the 
project can be run.

T o  d ow n l o a d  a  l o g i c  c om p on e n t  t o  t h e  C on t r o l l e r
• In the Project tab of the Navigator, right-click a target and choose Download.

All components on the selected target are validated then downloaded to the 
specified computer, if no errors exist. Errors listed in the Build tab of the Feedback 
Zone must be corrected before a download can be completed. Logic components 
are downloaded to the Controller while HMI components are downloaded to the 
View Runtime.

Although the Controller service is always running, you still have control over the 
execution of your control programs. Offline, you can start, stop and reset 
execution. When online to the Controller additional commands are available to 
pause, single-scan or enable forces. 

Want to know more? In the Help Index, look up Controller and choose “Controller: an 
Overview”.
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Controller3
Ru n  Mo de  S t o r e
Run Mode Store (RMS) functionality lets you update a target controller’s program 
without stopping the controller. It is supported on all Logic Developer - PC targets.

When you attempt to download your project to the Controller, a Run Mode Store 
dialog box appears with the following options.
■ Attempt a Run Mode Store: Machine Edition will attempt a Run Mode Store 

operation. That is, it will try to download your logic to the Controller while the 
Controller is running. 

■ Stop the controller, then download: Machine Edition will not attempt to use the 
Run Mode Store feature. Instead, it stops the Controller before initiating the 
download operation.

Several system tests and checks are performed when attempting a Run Mode Store 
operation. If these tests fail, the logic program may not be downloaded to the 
Controller.

T o  r un  t h e  C on t r o l l e r
• In the Project tab of the Navigator, right-click a target, point to Online or Offline Commands, and choose 

Start Runtime.
The ladder program, SFC program(s) and the ST block named ‘MAIN’ begin 
executing on the target computer or unit. If the target also has an HMI component 
(see page 72), the View Runtime is started at the same time as the Controller. 

To validate, download and run a project, right-click a target and choose 
Download and Start.

T o  c on f i g u r e  a n  HR T  C on t r o l l e r
Follow these steps if you’ve purchased the optional VenturCom RTX (HRT 
Controller).

1. Right-click a target and choose Properties.

2. In the Inspector, set the Hard Real Time property to True.
Any Controller operations carried out will now attempt to use an HRT Controller 
on the target computer. In order to use the HRT Controller, the VenturCom RTX 
software must also be installed on that target.

Want to know more? In the Help Index, choose “Run Mode Store (RMS)”.
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Controller
T o  a l l o w  an  HR T  C on t r o l l e r  t o  r u n  f o l l o w i n g  a  W ind ows  N T  f a i l u r e
1. Right-click a target and choose Properties.

2. In the Inspector, set the Delay Controller Shutdown property to True.
Any control programs (ladder, IL, ST or SFC) that are running in the specified HRT 
Controller will continue to run in the event of a Windows NT or hard drive failure. 
If the Delay Controller Shutdown property is set to False, the Controller will 
execute a graceful shutdown if Windows NT fails.

W a r m  S t a n d b y

The Warm Standby feature provides an extra level of reliability for critical 
Windows NT and Windows CE applications. It consists of two computers running 
the Logic Developer - PC Controller (a primary and secondary or standby 
computer), and an I/O switch that determines which computer is currently 
connected to the physical I/O.

When a system using warm standby is started, the primary computer is connected 
to the I/O, solves logic, and updates the secondary computer with critical data. 
The secondary computer receives the data and monitors the status of the primary 
computer. When a fault is detected in the primary computer, or when the 
secondary computer can’t communicate with the primary computer, the I/O 
connection is automatically switched to the secondary computer and the 
secondary computer takes over operations.

W o r k i n g  w i t h  W a r m  S t a n d b y

Note: You must set up the warm standby hardware before you can configure the 
warm standby program.

OP C  Se rv e r s  a nd  War m  S t andby
Warm Standby is fully supported by the Logic Developer - PC OPC server for 
CIMPLICITY Machine Edition. When a Warm Standby configuration file is 
detected, the OPC server:
■ Generates internal objects so that it will recognize all Warm Standby 

configurations as logical controllers to OPC clients.

■ Creates predefined OPC items for each logical controller. These items indicate 
which physical controller is active and the statuses of the primary and 
secondary controllers.

Want to know more? In the Help Index, choose “Warm Standby”.
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Controller3
To  c o n f i g u r e  Wa rm  S t an dby
1. In the Project tab of the Navigator, right-click a Windows NT or Windows CE target and choose Properties.

2. In the Inspector, scroll to the +Warm Standby property and double-click it to expand the group.
The Controller Mode property appears under the -Warm Standby group.

3. Click the Controller Mode property and choose a value from the list.

To  c o n f i g u r e  a n  OP C  s e r v e r  f o r  Wa rm  S tan dby
The configuration is specified in a user-defined XML file with the name 
WarmStandby.xml that must reside in the same folder as the LogicPC_OPC.exe file 
(that is, on the computer hosting the OPC server). In a default install of Machine 
Edition, this folder is C:\Program Files\Cimplicity Machine Edition\OPC.
56 Getting Started GFK-1868D



4 View
View is the human-machine interface (HMI) component of Machine Edition, 
providing the means to organize, track, display, and affect data from your plant or 
process. With View you create graphical panels, write scripts, configure alarm and 
logging schemes, and eventually launch the project into View Runtime. For 
Windows NT/CE targets, Web Documents adds the option of global accessibility 
by publishing data from Machine Edition projects to the Internet for remote 
viewing.

View supports HMI creation for Windows NT, Windows CE, and QuickPanel 
targets. QuickPanel targets share most of the same tools and editors with NT and 
CE targets; for more information, see “QuickPanel Applications” on page 76.

The following are included with View:
■  Panel Editor
■  Script Editor
■  Alarms
■  PLC Access Drivers
■  Language translation support
■  Logging (NT/CE targets only)
■  OPC Client & Servers (NT/CE targets only)
■  Web Documents (NT/CE targets only)
■  View Runtime (NT/CE targets only)
■  Message groups (QuickPanel targets only)
■  Password security (QuickPanel targets only)

T o  c r e a t e  a  p r o j e c t  t ha t  i n c l u d e s  a n  HMI  c om p on e n t
1. In the Manager tab of the Navigator, right-click My Computer and choose New. 

The New Project dialog box appears.

2. In the Project Name box, type a name for your project.

3. From the Project Template list, choose a template that includes an HMI component. 
A preview of what each template includes is displayed as you select different 
templates.

4. Click OK. 
Your new project is created and the Project tab is opened in the Navigator.

Navigator: Project tab

HMI component nodes
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P A N E L  E D I T O R
The Panel Editor is used to develop the layout of each panel in your application. 
With the Panel Editor, you create graphical objects and animate them with real-
time data to represent actual processes.

P a n e l s

Panels are the screens or windows for your HMI component. Each panel can be 
designed to represent a different view of your plant or process.
■ Graphical Objects: Bitmaps, geometric shapes, industrial illustrations, and real-

time charts are among the objects that can be added to a graphical panel.
■ Animation: Graphical Objects can be configured with up to nine different types 

of animation to move, change color, display data, trigger scripts, and receive 
input during Runtime.

T o  c r e a t e  a  n e w p a n e l
• In the Project tab of the Navigator, right-click the Graphical Panels folder and choose New Panel.

A new panel is added beneath the Graphical Panels folder in the Navigator. If 
you’ve created a project using a template, the Graphical Panels folder most likely 
already contains some default panels. 

T o  ope n  a  p a n e l  f o r  e d i t i n g
• In the Project tab of the Navigator, double-click a panel node.

The panel will open in the Panel Editor.

T o  c on f i g u r e  a  p a ne l
1. In the Project tab of the Navigator, right-click a panel and choose Properties. The Inspector will open, if it 

wasn’t already.

2. Set the panel’s properties in the Inspector. 
For a description of the panel properties, select a property and have a look at the 
Companion. Click  in the Tools toolbar to open the Companion window if it 
isn’t already open.

Want to know more? In the Help Index, look up panels and choose “Graphical Panels”.
Navigator: Project tab 

Panel Nodes
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Panel Editor
W o r k i n g  w i t h  t h e  P a n e l  E d i t o r

The Panel Editor interacts with all of the Machine Edition tools to aid you in the 
construction of graphical panels. The following picture illustrates some of the 
operations you can perform.

To  d r aw  a  g r aph i c a l  o b j e c t
1. If the Drawing toolbar is open, select the tool you want to use. Otherwise, right-click in the Panel Editor and choose 

a drawing tool. 
The Companion will display instructions on how to use the selected tool.

2. Follow the instructions in the Companion to draw your object.
Once your object is drawn, set its properties in the Inspector.

T o  a n i m a t e  a n  o b j e c t
• In the Panel Editor, double-click a graphical object. 

The Animation Properties dialog box opens. The settings of each animation type is 
grouped on its own tab. Animations become active when the project is launched 
with View Runtime. 

Want to know more? In the Help Index, look up panels and choose “Working with Panels”.

Chart and Alarm 
Objects update with 
real time data.

Drag items from the View 
Expert Objects drawer of 
the Toolchest to the Panel 
Editor.

The Feedback Zone 
updates with 
information when you 
validate, download, or 
run your project.

View toolbars provide
drawing and object
manipulation tools.

Panels are listed in
the Project tab of

the Navigator.

Configure graphical
objects in the Inspector.

The Companion displays
information for the

currently selected object,
tool, or property.
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Script Editor4
S C R I P T  E D I T O R
The Script Editor is a text editor that supports a various scripting languages, 
functions, keywords, and math operators. On Windows NT targets, you can also 
use Structured Query Language (SQL) in a script to access a database for which an 
Open Database Connectivity (ODBC) driver exists.

S c r i p t s
Scripts are short executable programs comprised of a sequence of instructions that 
tell a project, panel, or touch-animated object how to react to events during run-
time. There are four types of scripts:
■ Application Scripts: An application script is associated with an entire target, 

and can be configured to execute when the application is started (in View Run-
time), when the application is shut down, or based on a frequency or condition 
while the application is running.

■ Panel Scripts: A panel script is associated with a specific panel in a target, and 
can be configured to execute when the panel opens, when the panel closes, or 
based on a frequency or condition while the panel is open.

■ Touch Animation Scripts: (Windows NT/CE targets only.) Touch animation 
scripts are activated during Run-time by keystrokes and on-screen buttons. They 
are written directly in configuration dialog boxes of graphical objects.

■ Global Function Library Scripts: (Windows NT targets only.) Global Function 
Library scripts are associated with an entire target. By default, they are executed 
before any other scripts. However, they can be configured to run periodically or 
conditionally, based on the state of the application. Global Function scripts 
only work with scripts in Active Scripting languages, like VBScript.

To  c r e a t e ,  o p en ,  a n d  ed i t  a n  a pp l i c a t i o n  s c r i p t
1. In the Project tab of the Navigator, right-click the Application Scripts node, point to New Script, and choose 

either VBScript or ViewScript. (For more information on scripting, see page 61.)

2. Type a name for the new application script and press ENTER.
A new script is added to the Application Scripts node.

3. Double-click the script to open it in the Script Editor and begin editing the script.

4. In the Inspector, edit the application script properties, in other words, the activation type.

To  c r e a t e ,  o p en ,  a n d  ed i t  a  p an e l  s c r i p t
1. In the Project tab of the Navigator, right-click a  panel node, point to New Script, and choose either VBScript 

or ViewScript. (For more information on scripting, see page 61.)

2. Type a name for the new panel script and press ENTER.
A new script is added to the panel node.

3. Double-click the script to open it in the Script Editor and begin editing the script.

Navigator: Project tab

Script nodes
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4. In the Inspector, edit the panel script properties, in other words, the activation type.

T o  c r e a t e  a  t o u c h  a n i m a t i o n  s c r i p t
1. In the Panel Editor, double-click the object you want to animate. The Configure Animation dialog box appears.

2. Click the Touch tab.

3. Select the Enable Touch Action Animation check box and choose a touch action command that will execute a script.

4. In the large edit box, type the script that will run when the object is touched.

To  c r e a t e  a  g l o ba l  f u n c t i o n  l i b r a r y  s c r i p t
1. In the  Project tab of the Navigator, right-click the  Global Functions node, point to New Library, and choose 

VBScript.
A new script is added to the Global Functions node.

2. Double-click the script to open it in the Script Editor and begin editing the script.

3. In the Inspector, edit the Global Function Library script properties, in other words, the name.

S c r i p t i n g  L a n g u a g e s

On Windows NT targets, Machine Edition supports two types of scripting 
languages: ViewScript and VBScript Active Scripting languages (using Microsoft’s 
Active Scripting engine). On Windows CE targets, Machine Edition supports only 
proprietary ViewScript language.

On QuickPanel targets, Machine Edition uses the proprietary QPScript language 
(see page 82).

ViewScript scripting language

The ViewScript scripting language consists of the following:
■ Keywords: View script keywords are a basic set of commands that are used to 

control the flow of a script and to create local variables.
■ Operators: View operators are used to assign variable values and to perform 

mathematical operations
■ Script Functions: View script functions are commands that can be written into 

the body of your script to monitor and react to changes in variable values. 
Functions are grouped in the following categories: ActiveX, Alarm 
Management, Animation, Application Access, CSV, File Management, 
Initialization File Management, List and Combo Box, Logging, Miscellaneous, 
Network, Panel Management, Screen Navigation, Security, Serial 
Communication, Statistical Process Control, SQL, String, System, Trend 
Management, Video/Sound, and Web.
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■ Comments: Placing comments in, or between, the lines of your script is useful 
for debugging your script and for future reference. 

Active Scripting

Active Scripting lets Machine Edition use external scripting languages through a 
COM interface. Active Scripting languages are supported only on Windows NT 
targets. Currently, only the VBScript Active Scripting language is supported.

By default, new projects will use VBScript. This default may be overridden by 
setting a user-preference. 

Note: A target can contain both scripts written in ViewScript and scripts written in 
VBScript. However, troubleshooting such a project can be quite difficult, so this 
practice is not recommended.

Va l i d a t i ng  a  s c r i p t  wr i t t e n  i n  a n  A c t i v e  S c r i p t i n g  l a n gu age
Active scripting languages are validated at run-time. You can also validate a 
project at any time during development to check:
■ Syntax for View function calls.
■ Syntax for variable, array, and structure element references.
■ Limited checks for VBScript syntax.

V BSc r i p t  Sy n t ax
A detailed explanation of VBScript syntax is beyond the scope of this manual. For 
detailed information on the VBScript language usage, syntax and examples, look 
up VBScript at Microsoft’s website (www.microsoft.com).

Ac t i v e  S c r i p t i n g  Ob j e c t s
Active Scripting provides a mechanism to extend a scripting language through 
custom COM objects. Variable syntax is therefore limited to using properties and 
methods on a COM object.

There are four types of objects in VBScript: 
■ Variable objects.

Want to know more? In the Help Index, look up Viewscript and choose “ViewScript HMI 
scripting language”.

Want to know more? In the Help Index, look up scripts and choose “View Scripts: an 
Overview”, or look up scripting and choose “Active Scripting in View: an Overview”.

Want to know more? In the Help Index, look up VBScript and choose “VBScript language: an 
Overview”.
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■ Array objects.
■ Structure objects.
■ Application objects.

W o r k i n g  w i t h  t h e  S c r i p t  E d i t o r

The Script Editor interacts with other Machine Edition tools to provide maximum 
flexibility when editing a script. The following picture illustrates some of the 
operations you can perform.

There are many ways in which you can insert script words when writing scripts.
■ If you are very familiar with the operators, functions, and keywords used in the 

Script Editor, simply start typing your script directly in the Script Editor.
■ If you are not familiar with the scripting language of the Script Editor, you can 

easily use the right-click menu to access this information. Just right-click where 
you want to insert a function, operator, or keyword and select Insert. Then point 
to whatever it is you want to include in your script and make a selection from 
the list that appears. This also makes available names of variables, panels, 

Want to know more? In the Help Index, look up VBScript and choose “VBScript language: an 
Overview”.

Want to know more? In the Help Index, look up editor and choose “Working in the View 
Script Editor”.

The View Scripting 
drawer of the 
Toolchest contains 
script functions, 
keywords, and math 
operators that you can 
drag into your scripts.

Application scripts are
listed below the

Application Scripts
folder. Panel Scripts

are listed beneath the
panels they belong to.

The Companion displays 
help for the currently 
selected script function, 
keyword, math operator, 
or property.

A script can be set to
activate periodically,

or on condition.
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scripts, alarm groups and logging groups within the project that you can use in 
your script. For a description of a script function, keyword, or math operator, 
while in the Script Editor, place your cursor on the word for which you need 
help and press F1.

■ All the math operators, script functions, and script keywords are also listed in 
the Toolchest and can be dragged into your script. The Companion provides a 
description of each one.
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L O G G I N G
(Windows NT/CE targets only)

Logging keeps a history of data changes in your project so the data can later be 
analyzed. Logging groups and strategies are used to sort and manage logged data.

L o g g i n g  G r o u p s

Logging groups help to sort and organize your project data. Data can be collected 
in a default logging group or, if you want some variables to have different logging 
strategies, you will need to create a hierarchy of logging groups. This is 
recommended anyway as it helps to organize your logged data. 

Logging Strategies define when data gets logged for a group of variables. A group 
can be configured to log data periodically, on data changes, or on a condition.

To  en ab l e  l o gg i ng  o f  a  v a r i a b l e
1. In the Variables tab of the Navigator, right-click a variable and choose Properties. The Inspector will open if it 

isn’t already.

2. Set the Enable Logging property to True.
Logging is enabled for the variable, with RootLoggingGroup as the default logging 
group. 

T o  c r e a t e  a  n e w  l og g i n g  g r oup
1. In the Project tab of the Navigator, right-click the logging group node you want the new group to exist 

beneath hierarchically, and choose New.

2. Type a name for the new logging group and press ENTER.
Your new logging group appears beneath the logging group node.

To  ed i t  l o gg i n g  g r ou p  p r op e r t i e s
1. In the Project tab of the Navigator, right-click a logging group node and choose Properties.

2. Edit the properties in the Inspector.
During Runtime, the group will log variable data according to its properties. View 
information about selected properties in the Companion. Click on the Tools 
toolbar to open the Companion if it isn’t already open.

Want to know more? In the Help Index, look up logging and choose “Data Logging”.

Navigator: Project tab

Logging Group nodes
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A L A R M S
This section describes how alarms work for Windows NT/CE targets. For 
information on alarms in QuickPanel targets, see page 78.

Alarms let users know when conditions in a monitored process have gone outside 
the acceptable range. You configure alarms through properties of a variable. When 
a variable satisfies one of its alarm conditions, it goes into an alarm state.

A l a r m  O b j e c t s

Active alarms can be displayed in runtime with Alarm Objects. Alarm Objects 
dynamically update with information about alarm states. To set this up, all 
variables with alarming conditions need to be assigned to an alarm group.

A l a r m  G r o u p s

Alarm groups help you organize related alarm variables. Having more than one 
alarm group makes it easier to manipulate and view alarm data at runtime. A 
history of alarm group data can be logged daily for future analysis. You can also 
have an e-mail sent if any of an alarm group’s alarms go into an alarm state.

T o  s e t  a n  a l a r m  c o n d i t i o n
1. In the Variables tab of the Navigator, right-click the variable for which you want to set an alarm condition and 

choose Properties. The Inspector will open if it isn’t already. 

2. In the Inspector, double-click the Alarming property to set the general alarm parameters (the priority of the alarm, 
its alarm group, and how long to keep a history of alarm events).

3. Double-click the specific type of alarm (discrete alarms, limit alarms, deviation alarms, etc.) that you want to 
configure to set its alarm parameters.
These parameters establish the ranges that place the variable in an alarm state.

To  c r e a t e  a n  a l a r m  g r ou p
• In the Project tab of the Navigator, right-click the alarm group under which you want the new group to exist, 

and choose New. Type a name for the new alarm group and press ENTER.
Your new alarm group appears beneath the alarm groups node.

To  c r e a t e  a n  a l a r m  ob j e c t
1. In the Panel Editor, right-click and choose Alarm. The Alarm tool will be selected.

2. Draw an Alarm Object, using the information in the Companion as a guide.

3. Right-click the Alarm Object and choose Properties. The Inspector will open if it wasn’t already.

4. Set the Group property to the alarm group you want the Alarm Object to display information about in Runtime.
During Runtime, the Alarm Object will update with the alarm status of variables 
belonging to the associated alarm group and its subgroups.

Navigator: Project tab

Alarm nodes
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P L C  A C C E S S  I / O
PLC Access I/O is used to let your Machine Edition project communicate with I/O 
devices controlled by something outside the Machine Edition environment. 
Typically, that ‘something’ is a PLC: a special hardware device that controls input 
and output for other, simpler devices. For information on I/O communications with 
I/O devices, see “Structured Text Editor” on page 46.

D r i v e r s

PLC Access I/O is organized into Drivers and Devices:
■ Drivers are located in a target's PLC Access Drivers folder and represent the 

drivers the target uses to communicate with devices. Windows NT and CE 
targets can have many drivers; QuickPanel targets can have only one.

■ Devices represent the individual devices that a driver communicates with. 
All devices that a driver communicates with are located in that driver folder. A 
driver can have several devices. This allows you to talk to multiple PLCs, or (on 
Windows NT and CE targets) to get pieces of data from the same PLC at 
different rates.

To access data values from devices of a PLC Access driver, you must also create 
variables with a PLC Access data source. The configuration of these variables is 
unique for each kind of PLC Access driver; see the online help for more details.

To  add  a  P LC  A c c e s s  d r i v e r  t o  a  t a r g e t
1. In the Project tab of the Navigator, right-click the PLC Access Drivers node and choose New Driver.

2. Select a driver from the list provided and click OK.
The driver (and a single device) are added to your project. 

3. In the Inspector, configure the driver. If applicable, click the button in the driver’s Configuration property and 
enter values in the dialog box.

To  add  a  d ev i c e  t o  a  PLC  A c c es s  d r i v e r
1. In the Project tab of the Navigator, under PLC Access Drivers, right-click the driver to which you want to add 

a new device and choose New Device.

2. Type a name for the Device and click OK.
The device is added to your project. You can now edit the device’s properties in 
the Inspector.

Navigator: Project tab

PLC Access I/O Nodes
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O P C
(Windows NT/CE targets only)

OPC (OLE for Process Control) is an industry-standard protocol that lets software 
applications transmit I/O data to each other. The two applications have a client and 
server relationship. You can think of OPC Servers as being producers of 
information and OPC Clients as being consumers:
■ The OPC Server has data that it makes available to other OPC Clients.
■ The OPC Client connects to an OPC Server to gain access to the server’s data.

Since OPC is an industry standard, any OPC Client can access data from any OPC 
Server, regardless of the manufacturer. Machine Edition implements both the client 
and the server side of OPC communications.

Since an OPC Server and Client are simply programs or applications, they can run 
on the same computer. For example, in your factory, you could have another 
application that supports an OPC Client and a Machine Edition application 
running on the same computer. To allow them to share data, you’d set one of them 
up as an OPC Server and the other as an OPC Client, then have the client 
application establish a connection to the server.

OPC communications rely heavily on Microsoft’s OLE and DCOM technology. If 
an OPC Client is running on a different computer than the Server, you will have to 
edit the DCOM Security settings on one or both computers. For details, see the 
online help.

The OPC specifications are set and maintained by the OPC Foundation, a non-
profit organization. You can find detailed technical information about OPC on the 
OPC Foundation web site at www.opcfoundation.org.

O P C  C l i e n t

The OPC Client driver lets your Machine Edition application communicate with 
OPC Servers. This lets Machine Edition act as a client in the OPC Client/Server 
relationship.

The OPC Client folder is added to a target when you add an HMI component. Each 
OPC Server that the application communicates with is located under the OPC 
Client folder, much like devices of a PLC Access driver.

Want to know more? In the Help Index, look up “OPC: an Overview”.

Want to know more? In the Help Index, look up DCOM and choose “Configuring DCOM 
Security for OPC Communications”.

Navigator: Project tab

OPC Client Nodes
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To access data values from an OPC Server, you must also create and configure 
variables with an OPC data source.

To  add  a n  OP C  Se r v e r  l i n k  t o  t h e  O PC  C l i e n t  f o l d e r
1. In the Project tab of the Navigator, right-click the OPC Client and choose New Server Link.

2. Type a name for the OPC Server Link and click OK.
The OPC Server link is added to your project. You can now edit its properties in the 
Inspector.

M a c h i n e  E d i t i o n  O P C  S e r v e r s

Machine Edition OPC Servers let you share your application’s data with external 
OPC Client applications. This lets your Machine Edition application act as a server 
in an OPC Client/Server relationship.

Machine Edition OPC Servers are automatically installed as part of View Runtime 
and the Controller (sometimes referred to as the Logic Developer - PC Controller). 
Downloading and running a project to a target automatically enables the 
appropriate Machine Edition OPC Servers, based on the target’s components. For 
example, if your project has a Logic component, Machine Edition automatically 
enables the Logic Developer - PC OPC Server.

While the configuration of an OPC Client depends on the manufacturer, typically 
each piece of data retrieved from a server is called an “OPC Item”. All OPC Clients 
need to know how to address the data used by the server. The syntax for retrieving 
OPC items from a Machine Edition OPC Server can be found in the table below.

■ Local indicates that the appropriate Runtime is located on the same computer 
as the Machine Edition OPC Server. Remote indicates that it is located on a 
different computer.

■ The Machine Edition OPC Servers do not use access paths. Instead, as 
described above, the path for remote access is included as part of each OPC 
Item address.

Location Syntax

local <variable name> 
remote <remote machine name>\ <variable name> or 

<remote machine IP address>\ <variable name>
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W E B  A C C E S S
(Windows NT/CE targets only)

Web Documents provide remote access to Machine Edition project data over an 
Intranet or the Internet. When a Machine Edition project goes to runtime, it 
automatically launches an integrated web server. Users who connect to this web 
site are presented with the Site Index, which contains different ways to view 
process information.
■ Remote Views: Dynamic graphical recreations of actual panels from the 

Runtime display. 
■ Custom Web Documents: Web documents that have been generated using 

templates and special HTML tags that are replaced with current project 
information from the project each time an instance is generated. You can view 
the documents online or print them for distribution.

■ Variable Monitor Browser: An application that allows you to drag and drop 
variables from Web Documents servers onto four unique viewing tools for 
dynamic graphical representations of process data.

■ Remote Variable Inspector: Lets you select a variable from a list of project 
variables in a project and immediately receive the current value.

■ Web Control: Lets you write changes to a target’s data from Web Documents. 
Before using this feature, ensure that your intranet installation is secure and that 
no safety concerns exist with web control of a target.

T o  a l l o w  r e m o t e  a c c e s s  t o  yo u r  p r o j e c t
1. For each target that you want to allow access to, set the target’s Enable Web Server property to True.

2. For each item in those targets that you want users to be able to access, set its Publish property to True.
For example, to allow users to view a graphical panel remotely, set the panel’s 
Publish property to True.

T o  a c c e s s  t h e  We b  D o c u me n t s  S i t e  I n de x
1. Start Internet Explorer 4 or later. If you don’t have Internet Explorer 4 or later, you can install it from the Machine 

Edition installation CD.

2. In the Address box in Internet Explorer, type the computer name or IP address of the Runtime computer.

3. If you’re not sure what the Runtime computer’s computer name or IP address is, check the properties of the TCP/IP 
driver in the Control Panel Network setup, or contact your network administrator.

Want to know more? In the Help Index, look up web and choose “Web Access: an Overview”.

Navigator: Project tab

Web Document nodes
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4. If you’re testing the project on the local computer, enter “localhost” (without the quotation marks) as the Address. 
This connects Internet Explorer with the local computer.
When you connect to the Runtime computer, the Site Index appears with a list of 
links to possible ways to view your process data.
The Site Index also includes a link to a page where you can download the Web 
Documents Browser. With it, you can configure graphs, tables, and ticker tapes to 
report on variables from several Machine Edition applications at once.

T o  v i e w  a n i m a t e d  p ane l s  r e mo t e l y
You can select to view graphical panels from the Web Documents Site Index.

1. Start Internet Explorer 4 or later.

2. In the Address box in Internet Explorer, enter the computer name or IP address of the Runtime computer.
The Site Index appears.

3. Click Remote Views.

4. Click the panel you want to view.
After a few moments, the panel will load and run.
Note that the panel must be published for you to be able to view it remotely. To 
publish a panel, set its Publish property to True.
Since the remote viewer uses a different graphics engine to draw and update a 
graphical panel, there may be a few differences between the remote view of a 
panel and its actual appearance on an HMI. For example, chart objects on panels 
are not supported in remote views.

T o  c r e a t e  a  n e w Cu s t om  W eb  D o cu m e n t
1. In the Project tab of the Navigator, right-click the Web Documents node and choose New Web Document. 

2. Type a name for your new document and press ENTER. 
Your new Custom Web Document appears beneath the Web Documents node. 
You can edit properties of the Custom Web Document in the Inspector.

T o  ed i t  a  C u s t o m  W e b  Do c um e n t
1. Outside of Machine Edition, create an HTML, XML or text (txt.) document.

2. In the Project tab of the Navigator, right-click the Custom Web Document you want to edit and choose Web 
Document Files. The Web Document Files folder opens.

3. Place your HTML document and any logos or pictures your HTML document uses in the Web Document Files folder.
The Web Document is created from these files when you download your project. 
You can view Custom Web Documents from the Site Index.
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V I E W  R U N T I M E
(Windows NT/CE targets only)

View Runtime is the program that runs your project’s completed HMI (human 
machine interface) on a target computer. It uses the files downloaded to the target 
during the download process. It is a separate application from Machine Edition; 
while you can start View Runtime from within Machine Edition, you do not need 
to be running Machine Edition to use it.

N e t w o r k i n g

View Networking provides you with the flexibility to exchange data between 
Runtime stations. Based on client-server relationships, and supporting a distributed 
database system, View Networking allows access to any variable or alarm group 
running on any other target on the computer network.

T o  r un  a  p r o j e c t  f r o m Ma ch i ne  Ed i t i o n
• In the Project tab of the Navigator, right-click a target and choose Download and Start.

All components on the selected target are validated, downloaded to the specified 
computer, and the Runtime started. Errors listed in the Build tab of the Feedback 
Zone must be corrected before a download can be completed. HMI components 
are downloaded to View Runtime while logic components are downloaded to the 
Controller.

T o  r un  a  p r o j e c t  o u t s i d e  o f  Ma c h i n e  E d i t i o n
• Click the Start menu, then go to Programs/CIMPLICITY Machine Edition. Click View Runtime.

Runtime starts with the last project that was downloaded to that computer. View 
Runtime opens with all graphical panels configured to appear at startup (that is, all 
graphical panels whose Visible at Startup property is True).

T o  i n t e r a c t  w i t h  V i e w R un t i me
Graphical objects can be configured to allow you to change variable values, 
trigger graphical animations, and execute custom scripts with a simple touch or 
click.

Want to know more? In the Help Index, look up runtime and choose “View Runtime: an 
Overview”.

Want to know more? In the Help Index, look up networking and choose “View Networking: an 
Overview”.

Navigator: Project tab

Target node
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You can monitor variable values, scripts, drivers, and the integrated web server in 
Runtime through interfaces that can be opened using the following shortcut keys:

L A N G U A G E S  F O L D E R
The Languages item opens a grid that lets you configure multi-language support 
for an HMI. You set up simple translations between an original piece of text (called 
the “Source”) and one or more languages. If the target’s Language Translation 
property to Enabled, all text on the HMI’s graphical panels is then translated based 
on one of the language columns in the grid—the “Current Language”. That is, 
every occurrence in the original text is replaced with its corresponding item in the 
Current Language.

During a validation or download, Machine Edition also checks the Source column 
against all graphical panels to which you’ve made changes. Any text entries (in text 
objects and button objects) that do not appear in the Source column are 
automatically added to the grid as rows with empty translations for all languages.

Windows NT/CE targets: Machine Edition includes the entire language table when 
downloading the project to the target. Translation occurs dynamically at runtime. 
Within HMI scripts, you can change the current language used for translation by 
calling the SetLanguage script function. 

QuickPanel targets: Translation occurs only during the download operation. You 
cannot dynamically change the current language at runtime.

To ... Press ...

log in CTRL+L
log out CTRL+U
close Runtime CTRL+Z
inspect and change variable values CTRL+I
view and debug scripts CTRL+G
view driver diagnostic information CTRL+D
open a panel CTRL+O
monitor the Web Documents server CTRL+W
display version information CTRL+B

Want to know more? In the Help Index, look up “Languages folder”.

Navigator: Project tab

Languages node
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W o r k i n g  w i t h  t h e  L a n g u a g e s  e d i t o r

When you double-click a target’s Languages node, the Languages grid appears.

To edit or enter the translation of a particular word for a language, double-click its 
cell (or select the cell and either start typing or press F2). For a menu of commands, 
right-click anything in the Languages grid. 

To  add  a  n e w l a n gu age  c o l umn
1. Right-click in the Language Grid, and select Add Column. 

A new, empty column is added to the grid. 

2. Enter the name of the new language in the column’s header text box. To cancel the addition of the column, leave the 
text box blank and click outside the column header (or press ESC). 
You can now edit the translation for the new language as normal. 

T o  r e nam e  a  l a ng uag e  c o l u m n
• Right-click in the Languages Grid and select Set Column Name (or double-click the column header). 

Enter the new name for the language in the column’s header text box. 

The “Source” column contains the original 
words and phrases to be used during the 
translation process, as they appear in the 
target’s graphical panels.

This column’s shaded yellow background 
indicates that it is the default language. When 
Language Translation is enabled, this is the first 
language used as the “Current Language”.

To enter a value into a cell,
double-click it (or select the cell

and start typing).

If both the development and runtime computers support
UniCode, you can use non-English character sets in the

grid (such as Japanese, pictured). For example, In
Windows 2000 you can use the IME, configured in the

Regional Settings setup in the Control Panel.

The Languages Editor
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T o  mo ve  a  l a ng uag e  c o l u mn
• In the Languages Grid click and hold the header of the column you want to move. 

Drag the mouse to the place where you want to move the column, then release the 
mouse button. 

T o  u p d a t e  e n t r i e s  i n  t he  Sou r c e  c o l umn  w i t h  n ew  tex t  en t r i e s  i n  g r a p h i c a l  p a ne l s  
• In the Navigator, under the target whose Languages grid you want to update, right-click the Languages node and 

select Update Source Column. 
View searches every graphical panel in the HMI (regardless of whether or not the 
panel changed since the last validation) and makes sure that all text entries can be 
found in the Languages grid. 

T o  c ha nge  t he  d i s p l ay  f o n t  f o r  a  l a n gu age :  
1. Right-click in the Languages grid, and select Set Column Font. 

A Font dialog box appears. 

2. In the Font dialog box, select the font you want to use to display the entries in the Languages grid, along with the 
font style and other attributes. 
The grid’s cells automatically resize to fit the height of the largest font used in the 
grid 

3. Click OK when you’re done. 
The selected font set is used to display the translated text both in the Languages 
grid and (in Windows NT/CE targets) the downloaded HMI. Other font attributes—
such as font sizes and styles—only affect how the text appears in the grid at 
development time. 

T o  s e t  t h e  d e f a u l t  l a n gua ge  c o l u m n
• In the Languages grid, right-click the column you want to set as the default language and select Set Default 

Column. 
The yellow highlight moves to the selected column. The next time you download 
the project to the target with translations enabled, the default language will be 
used by default. Note that you can also set the Source column as the default.

T o  d e l e t e  a  l a n gu age  c o l um n  f r om  t h e  g r i d :  
• In the Languages grid, right-click the column you want to remove and select Delete Column. 

The column and all its translations are deleted. 
This operation cannot be undone. Before deleting a language, make sure you no 
longer need information on translated words. 
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Q U I C K P A N E L  A P P L I C A T I O N S
QuickPanel applications are HMI (human-machine interface) applications for 
QuickPanel units. CIMPLICITY View supports development of HMI applications 
using standard View and Machine Edition tools. QuickPanel application 
development includes the following items and features:
■ Panel Editor: Design each graphical panel for your QuickPanel display, using a 

wide selection of graphical objects including a variety of user-configurable 
buttons.

■ Grid Editors: Several items in QuickPanel targets use a grid editor. This editor 
looks and works much like a spreadsheet application. Items that use grid editors 
include Word Alarm groups, Bit Alarm groups, LMD (Local Message Display) 
groups, TMD (Triggered Message Display) groups, Selector Switches, Trend 
displays, Bar Graphs, the Passwords list, the keypad assignment feature, and 
LID (Local Image Display) groups.

■ Integration with Logic Developer - PLC: If you also have Logic Developer - PLC 
installed, you can use variables on a GE PLC target directly in your QuickPanel 
application. To use this feature, both the GE Fanuc PLC target and the 
QuickPanel target must be part of the same project. You must also configure an 
appropriate PLC Access driver and device on the QuickPanel target, setting its 
“PLC Target” property to point to the PLC target. (For more information about 
using GE PLC variables, see GFK-1918: Getting Started Logic Developer - PLC.)

■ Integration with the Machine Edition environment: QuickPanel development 
uses all the standard Machine Edition tools and utilities, including the Inspector, 
the Feedback Zone, the Toolchest, and a project's Variable List. For more 
information, see Machine Edition Environment page 10.

Want to know more? In the Help Index, look up QuickPanel, and choose “QuickPanel 
Applications: an Overview”, “QuickPanel Target”, and “QuickPanel vs. NT/CE application 
development”.

Navigator: Project tab

QuickPanel nodes
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Q U I C K P A N E L  P A N E L  E D I T O R
The QuickPanel Panel Editor is used to create and edit panels for your QuickPanel 
HMI (Human Machine Interface). Each panel is a single screen or window of your 
HMI. You draw and configure graphical objects on the panel to create each 
screen. Navigation between panels is done through the Goto button graphical 
object.

Graphical objects are the various graphical elements of the HMI screen, such as 
rectangles, polygons, buttons, and alarm displays. All objects are available from 
the QuickPanel tools toolbar. Many items (such as buttons) perform actions when 
you tap them at runtime.

The Panel Editor displays the current panel as it will appear on the QuickPanel 
target unit when you download the project. In addition, the Panel Editor adds a 
tiling grid and a drawing grid. The tiling grid lets you align graphical objects with 
the touch-sensitive cells on the surface of a QuickPanel unit’s display.

P a n e l s  o n  Q u i c k P a n e l  t a r g e t s

Panels are the screens or windows of your QuickPanel HMI (Human Machine 
Interface). You edit panels in the Panel Editor, where you can draw graphical 
objects, insert bitmaps, and develop the layout of each panel in the project. In the 
Navigator, panels are organized under the  Graphical Panels folder.

You work with Panels on a QuickPanel target in much the same way as NT and CE 
targets. Some of the differences are:
■ QuickPanel targets support a different set of graphical objects. Many are similar, 

but some are unique to QuickPanel targets.
■ QuickPanel targets do not support Animation in the same way as NT and CE 

targets. Instead, all object configuration takes place in the Inspector, or an 
appropriate grid editor (see page 78).

For a description of a panel’s properties, select a property and look in the 
Companion window. Click  in the Tools toolbar to open the Companion if 
necessary.

Want to know more? In the Help Index, look up QuickPanel, and choose “QuickPanel Panel 
Editor”.

Want to know more? In the Help Index, look up QuickPanel, and choose “QuickPanel Panel 
Editor”, “QuickPanel graphical panels”, and “QuickPanel graphical objects”.

Navigator: Project tab 

Panel Nodes
Getting Started 77GFK-1868D



V i e w

Grid Editors4
G R I D  E D I T O R S
The Grid Editor lets you create and edit several items in QuickPanel targets. This 
editor looks and works much like a spreadsheet application.

Items that use grid editors include:
■ Word Alarm groups
■ Bit Alarm groups
■  LMD (Local Message Display) groups
■  TMD (Triggered Message Display) groups
■  Selector Switches
■  Trend displays
■  Bar Graphs
■  Passwords list
■ External Keypad assignment configuration.

A l a r m s

Alarms are messages that appear on a display in response to specified conditions 
in the system. These messages typically inform the operator of a situation that 
requires immediate attention. 

In QuickPanel target, there are two areas in which you configure alarms:
■ Create and edit your desired Word Alarm Groups and Bit Alarm 

Groups, located under the target’s Alarm Groups folder. Each alarm group 
consists of a table of alarm entries. Each entry in a group specifies a variable, a 
value of that variable that will trigger an alarm condition, and the 
corresponding message to display.

■ Add an Alarm Window graphical object to one of the QuickPanel 
application’s panels. This graphical object displays alarm state information at 
run-time. When a variable and its value match an entry in one of the target’s 
alarm groups, the corresponding message appears in the Alarm Window.

Want to know more? In the Help Index, look up QuickPanel, and choose “Working with 
QuickPanel grid editors”.

Want to know more? In the Help Index, look up alarms and choose “QuickPanel Alarms: an 
Overview”.

Navigator: Project tab 

Grid Editor Nodes
78 Getting Started GFK-1868D



V i e w
Grid Editors
To  c r e a t e  a n  a l a r m  g r ou p
• In the Project tab of the Navigator, under the target’s Alarm Groups folder, right-click the Bit Alarms or 

Word Alarms folder (as appropriate) and choose New. Type a name for the new alarm group and press ENTER.
Names must be unique within a target.

To  c r e a t e  a n  A l a rm  g r aph i c a l  o b j e c t
1. In the Panel Editor, right-click and choose Alarm. The Alarm tool will be selected.

2. Draw an Alarm Object, using the information in the Companion as a guide.

3. Right-click the Alarm Object and choose Properties. The Inspector will open if it wasn’t already.

4. In the Inspector, edit the alarm object’s properties as desired.

M e s s a g e  D i s p l a y s

The Local Message Display, Triggered Message Display, and Local Image 
Display graphical objects display different messages or images based on the values 
or states of associated variables. Each of these three objects is associated with a 
message group of an appropriate type under the Message Groups folder—an 

LMD Group, TMD Group, or LID Group.

Each graphical object can be associated with only a single message group, but that 
message group may be associated with many graphical objects. The size of all 
graphical objects associated with the same message group must be the same; this 
size is set in properties of that message group. You can open the grid for an 
associated message group by clicking the button in the object’s 
“LMD/TMD/LID Group” property.

Entries in a message group are edited in an appropriate grid editor.

■ A Local Message Display graphical object shows text messages that change 
depending on the value or state of a single associated variable. The colors and 
appearance of the display can also change. The values and related appearances 
are set by the display’s associated LMD Group.

■ A Triggered Message Display graphical object shows text messages that 
change depending on the results of boolean expressions. The colors and 

Want to know more? In the Help Index, look up LMD and choose “LMD (Local Message 
Display) group” and “LMD (Local Message Display) grid”.
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Grid Editors4
appearance of the display can also change. The values and related appearances 
are set by the display’s associated TMD Group.

Unlike a Local Message Display, you do not associate a variable with a 
Triggered Message Display. Instead, you specify a series of boolean expressions 
in the TMD Group grid editor.

■ A Local Image Display shows different images depending on the value or 
state of a single associated variable. The values and related images are set by 
the display’s associated LID Group.

An image in an LID Group is typically a bitmap, imported from a BMP file. 
Images can also be sets of simple graphical objects (Arcs, Bitmaps, Circles, 
Lines, Pie Wedges, Polygons, Polylines, Rectangles, Round Rectangles, and 
Text).

E x t e r n a l  K e y p a d  A s s i g n m e n t

Some QuickPanel units support an external keypad. You enable the keypad by 
setting the target’s External Keypad property to True; this enables keypad 
configuration elsewhere in the application. There are two ways to assign an action 
to a keystroke:

■ In the graphical panel, graphical objects that can have an assigned keystroke 
will display a Key Assignment property. In this property, you can select a key 
that will activate that graphical object just as if an operator tapped it on the 
display.

■ Actions not associated with a graphical object that appears in the panel are 
configured in the Keypad Assignment grid. Each panel has a separate Keypad 
Assignment grid.

To open the Keypad Assignment grid for a panel, select the panel’s Keypad 
Assignment property and click its button. Each row of the grid specifies the 
action to perform when the user presses the indicated key while that panel (and 
only that panel) is open.

Want to know more? In the Help Index, look up TMD and choose “TMD (Triggered Message 
Display) group”, “TMD (Triggered Message Display) grid”, and “Trigger Expression dialog box (TMD 
grids)”.

Want to know more? In the Help Index, look up LID and choose “LID (Local Image Display) 
group” and “LID (Local Image Display) grid”.

Want to know more? In the Help Index look up keypad and choose “Keypad Assignment Grid” 
and look up QuickPanel and choose “Working with QuickPanel grid editors”.
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Scripts on QuickPanel Targets
S C R I P T S  O N  Q U I C K P A N E L  T A R G E T S
Scripts are sets of instructions that tell a project or panel how to react to events 
during Runtime. Scripts on QuickPanel targets are written in a proprietary language 
called “QPScript”. You create QuickPanel scripts using the same View Script editor 
as Windows NT/CE targets (see page 60).

There are two types of scripts for QuickPanel applications:

Application Scripts: Application scripts are associated with a QuickPanel target. 
These scripts can be executed any time your project is running on the target 
platform. Application scripts are located under the  Application Scripts folder in 
the Navigator.

Panel Scripts: Panel scripts are associated with a graphical panel on a QuickPanel 
target. All of a panel's scripts are located under its  Panel node in the Navigator.

To  c r e a t e ,  o p en  a nd  e d i t  a n  a pp l i c a t i o n  s c r i p t
1. In the  Project tab of the Navigator, right-click the  Application Scripts node, and choose New Script.

2. Type a name for the new panel script and press ENTER.
A new script is added to the Application Scripts node.

3. Double-click the  script to open it in the Script Editor and begin editing the script.

4. In the Inspector, edit the application script properties.

To  c r e a t e ,  o p en  a nd  e d i t  a  p ane l  s c r i p t
1. In the  Project tab of the Navigator, right-click a  panel node, and choose New Script.

2. Type a name for the new panel script and press ENTER.
A new script is added to the panel node.

3. Double-click the  script to open it in the Script Editor and begin editing the script.

4. In the Inspector, edit the panel script properties.

Want to know more? In the Help Index look up QuickPanel and choose “QuickPanel Scripts: 
an Overview”.Navigator: Project tab 

Script Nodes
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Scripts on QuickPanel Targets4
Q P S c r i p t  L a n g u a g e

The QPScript language is composed of the following elements.

Statements: There are three general kinds of statements in a QPScript script:
■ Assignment statements set a variable’s value to the result of an expression.
■ Function calls execute one of the QPScript functions to perform a specific 

operation. 
■ Branching statements change the flow of script execution.

Keywords: The elements that make up these statements can be broken down into 
the following categories:
■ Operators are used in mathematical expressions and conditional expressions.
■ Functions are predefined routines that perform various operations in the 

QuickPanel application.
■ Keywords are other reserved words used in the QPScript language.

Expressions: There are two general kinds of expressions in QPScript:
■ Mathematical expressions produce numerical results.
■ Conditional expressions produce boolean results and are used in if-then-else 

clauses.

Want to know more? In the Help Index, look up QPScript and choose “QPScript Language 
Reference”.
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5 Motion Developer
Motion Developer lets you easily program Whedco’s IMC, IMCjr (IMJ), and SMJ 
series or GE Fanuc’s S2K series of motion control devices. With Motion Developer, 
you can:

■ Run easy-to-use wizards to set up and configure a complete motion control 
system in a few mouse-clicks.

■ Add motion controller targets to a Machine Edition project.

■ Edit motion blocks and programs for motion controllers with the Motion 
Developer Script Editor.

■ Download programs and motion blocks to motion controllers through a serial 
port or a DeviceNet network.

■ Work online with a downloaded motion application, viewing and monitoring 
variable values as the motion controller’s programs run.

Motion Developer is fully integrated with the Machine Edition environment and 
Machine Edition tools.

T o  c r e a t e  a  M o t i o n  D e ve l o pe r  p r o j e c t
1. In the Manager tab of the Navigator, right-click My Computer and choose New. 

The New Project dialog box appears.

2. In the Project Name box, type a name for your project.

3. From the Project Template list, choose either the Motion Controller or Motion Drive template.
A preview of what each template includes is displayed as you select different 
templates.

4. Click OK.
Your new project is created and the Project tab is opened in the Navigator.

Navigator: Project tab

Motion device nodes
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About Motion Developer5
A B O U T  M O T I O N  D E V E L O P E R
You use Motion Developer to develop motion applications on Windows-based 
computers. Motion applications are loosely defined as a series of motion device 
targets with programs, motion blocks, and configuration data. These applications 
can then be downloaded to the motion controller hardware, either directly 
(through the computer’s serial port) or through a DeviceNet network.

In general, you go through the following phases when developing a motion 
application

1. Create a new Machine Edition project.

2. Add a Motion Controller or Motion Drive target to the project, depending on the kind of motion device.

3. On each target, create the configuration script and (if appropriate) the programs and motion blocks for the motion 
controller or drive. The Motion Wizards (see page 89) can make this easy.

4. Validate and download the application to the motion controller.

The Motion Expert wizard will take you through these items step by step.

S u p p o r t e d  m o t i o n  c o n t r o l  d e v i c e s

Motion Developer supports the following lines of motion control devices.

■ For the most up-to-date hardware documentation on Whedco motion devices, 
see the Whedco web site at www.whedco.com.

■ Many hardware manuals and specifications for GE Fanuc motion devices can 
be found on the GE Fanuc web site at www.gefanuc.com.

Communications between the development computer and motion control devices 
is supported over the COM port and over DeviceNet networks.

Whedco™ motion control devices IMC motion controllers
IMCjr (IMJ) motion controllers
SMJ drives

GE Fanuc™ motion control devices S2K controller/drive devices
S2K drive-only devices
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Motion Applications
M O T I O N  A P P L I C A T I O N S
A typical Motion application consists of a single target. Your project can have as 
many targets as you want, however. 

M o t i o n  t a r g e t s

A Motion target represents a runtime destination motion device that you 
program and configure from Machine Edition. You’ll need a separate target for 
each physical motion device you’ll be configuring, whether it’s a controller or a 
drive-only device.

When adding a Motion target, you specify either a Controller or a Drive target. This 
determines the models of controller you can select in its Controller Type property.
■ Drive targets represent drive-only motion devices. This includes Whedco SMJ 

devices and GE Fanuc S2K drive-only devices. These targets only have a 
Configuration script (page 86).

■ Controller targets represent controller/drive motion devices. This includes 
Whedco IMC and IMCjr (IMJ) devices, as well as GE Fanuc S2K 
controller/drive devices. These targets have a Configuration script (page 86), 
Motion Programs (page 86), and can have several Motion Blocks (page 87). In 
addition, they can make use of a CAM Profile. (see page 95).

To  ed i t  c o n f i g u r a t i o n  s c r i p t s ,  mo t i o n  p r o g r a ms ,  a n d  mo t i o n  b l o c k s
1. In the Project tab of the Navigator, under the motion target, right-click Configuration, or the motion 

program or motion block you want to edit and select Open.

2. Create or edit the program in the appropriate editor.

3. After editing an item, make sure you download the program or project to the target hardware.
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Motion Applications5
T o  sw i t c h  b e t we e n  a  w i z a r d  e d i t o r  a n d  t h e  m o t i o n  s c r i p t  e d i t o r
Motion blocks and Motion programs can be edited either in a graphical wizard or 
(for advanced users) in the motion script editor.

• In the Project tab of the Navigator, under the motion controller target’s Programs folder, right-click the 
motion program or motion block whose editing method you want to change.

■ If the item is set up to be edited in a wizard and you want to edit its script 
directly, select Text View.

■ If the item is set up to be edited in scripts directly and you want to return to 
using the wizards, select Flowchart View or Calculator View, as appropriate.

When switching back to the wizard, changes you made in the script editor will be 
lost. The item will return to the state it was in when last edited in the wizard.

M o t i o n  c o n f i g u r a t i o n

The motion controller configuration node represents a script used to configure 
the motion controller when the application is downloaded. This script runs every 
time the application is downloaded to the motion controller. Typically, it sets 
default values for registers and performs any necessary initialization commands.

■ You can create and edit a configuration script with the Motion Configuration 
wizard (right-click Configuration and select Wizard). This takes you through 
motion controller configuration step by step, creating a script based on selected 
motor and axis parameters.

■ If you need more complexity, you’ll need to edit the script manually. You can 
do so in the motion script editor (right-click Configuration and select Open).

M o t i o n  p r o g r a m s

A program represents one of the motion controller’s programs. Programs are 
scripts that control the operation of a motion controller. With programs, you can 
create complex behaviors for the controller.

Motion controller targets have four programs. These are added to the target when 
you first create it. The last program ( Program 4) is the fault-handling program, 
which determines the behavior of the controller when an exception or fault 
occurs. All programs for a target are located in its Programs folder.

Want to know more? In the Help Index, look up “Motion Controller Configuration”.

Want to know more? In the Help Index, look up “Fault-handing motion program”.

Navigator: Project tab

Configuration node

Navigator: Project tab

Motion Program nodes
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Motion Applications
You can edit programs either in the Application Builder (by default) or the Motion 
Script Editor.
■ The Application Builder is a wizard that lets you visually specify the program 

flow as a flowchart. For details, see page 91.
■ The Motion Script Editor lets you edit the script for a motion program manually. 

For details, see page 88.

M o t i o n  b l o c k s

A Motion node represents a motion block for the motion controller target. 
Motion blocks are defined motions (that is, motion scripts) that can be called by 
motion programs. With motion blocks, you can create complex motions—such as 
blended moves—without the need for conditional or WAIT statements.
■ You can run motion blocks separately with the Controller Functions wizard (see 

page 90).

You can create a motion block with the New Motion Block wizard (right-click the 
Motions folder and select Wizard). This creates a complete motion block based on 
your motion system.
■ Advanced users can create an empty motion block by right-clicking the 

Motions folder and selecting Add.

Once a motion block is created, you can edit it by right-clicking the Motion and 
selecting Open. You edit motion blocks and motion programs either with the 
Motion Calculator (see page 93) or in the Motion Developer Script Editor (see page 
88).

Motion blocks have the following characteristics and restrictions.
■ Motion blocks complete executing one line of code before proceeding to the 

next line of code.
■ Only one motion block per axis can run at the same time as the executing 

program or programs.
■ When a motion block is executed, it overrides the currently executing motion 

block.
■ You cannot use labels in a motion block.

Want to know more? In the Help Index, look up “Motion Programs”.

Want to know more? In the Help Index, look up “Motion blocks”.

Navigator: Project tab

Motion block nodes
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Motion Scripts5
M O T I O N  S C R I P T S
The Motion Script Editor interacts with other Machine Edition tools to provide the 
most flexibility when editing a script. The following diagram illustrates some of the 
operations you can perform.

There are many ways to insert items when writing motion scripts.
■ If you are very familiar with the registers, commands, and operators used in 

Motion scripts, simply start typing your script directly in the Script Editor.
■ If you need help with script keywords, you can add items with right-click 

menus. Right-click where you want to insert an item and select Insert. Then, 
point to what you want to include in your script and make a selection from the 
list that appears. For a description of a register or command in the Script Editor, 
move the cursor on the word for which you need help and press F1.

■ The Motion drawer in the Toolchest contains items that can be dragged into 
your script. Leave the Companion window open for a description of each item.

■ You can also drag variables directly from the Variables tab of the Navigator 
into your script.

Want to know more? In the Help Index, look up “editor” and choose “Working in the Motion 
Script Editor”.

The Motion Developer 
drawer in the Toolchest 
contains registers, 
commands, and 
operators you can drag 
to a motion script. 

You can also add items 
into your script by 
right-clicking in the 
editor window.

You can drag
variables from the

Variables tab directly
into a motion script.

The Companion displays 
help for the currently 
selected register, 
command, or operator.
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Motion wizards
M O T I O N  W I Z A R D S
Wizards are a series of screens that take you, step by step, through the creation and 
configuration of your motion controller application. In Motion Developer, wizards 
appear in separate windows, so you can switch back and forth between them.

The most commonly used Motion Developer wizards are as follows.

Nav iga t i ng th r ough  Mot ion  wiza rds

Pages of a Motion Developer wizard work just like HTML pages in a web browser. 
Click buttons and hypertext links to move from page to page or to perform the 
labeled task. Within a single wizard, you can move between steps by clicking 
buttons in the top left corner of each page:

Buttons may be disabled depending on the situation. For example, if you need to 
make selections or enter parameters before continuing, the “next” button will be 
disabled.

Depending on the page, two additional buttons may be enabled in the top right 
corner:

Main Wizard Provides access to several other wizards and tools for a motion 
controller target. Especially useful is the Motion Expert wizard, 
which takes you through the creation of a complete application step 
by step.

Application Builder Lets you create motion programs as a visual flowchart. See page 91.
Motion Calculator Lets you define simple, incremental motions for motion blocks. See 

page 93.
Controller Functions Provides access to several tools and online operations for the motion 

controller.

Click to jump to the first page in the wizard.

Click for more specific help on the current wizard or the current step.

Click to close the wizard, saving any 
changes you made to the project.

Click to close the wizard without saving 
any changes you made.

Click to go to the next page in the wizard.Click to go to the previous page in the wizard.
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Motion wizards5
Many wizard pages contain tables of parameters. Edit the parameters based on 
your system needs, then click Next.

■ When editing parameters, click Use Last Saved Values to revert back to the last 
values saved for this wizard page. Click Use Default Values to fill in parameters 
with default or calculated values.

■ Click a parameter’s button (to the right of its entry text box) for a short 
description, including its minimum, maximum, and default values. Click the 

button for a more detailed description of that parameter.

Wizards for different targets, motions, and programs open in separate windows. 
You can switch between windows by clicking the tabs at the bottom of the editor 
window display.

Two of the most important wizards are the Main Wizard and the Controller 
Functions wizard.

■ The Main Wizard page provides access to most other major Motion Developer 
wizards and tools. This includes the Motion Expert wizard, which takes you 
through the creation of a complete Motion Developer project step by step. To 
open the Main Wizard page for a target, right-click the target and select 
Main Wizard.

■ The Controller Functions and Drive Functions wizards let you perform 
diagnostic and other operations on the motion controller. Functions on these 
wizards have no effect if the local computer is not connected to a motion 
controller. To access these wizards, double-click the target you want to perform 
the functions on or, while working with a target, click the Controller/Drive 
Functions button.

Want to know more?
■ For a description of the wizards available from the Main Wizard page, in the Help Index, look 

up “Main Wizard page”.
■ For a description of features available from the Controller Functions wizard page, in the Help 

Index, look up “Controller Functions wizard”.
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Special Wizards
S P E C I A L  W I Z A R D S
Two of the wizards in Motion Developer—specifically, the Application Builder 
and the Motion Calculator—let you edit parts of your motion application in 
graphical editors. 

A p p l i c a t i o n  B u i l d e r  f l o w c h a r t  e d i t o r

The Application Builder is a wizard that lets you edit your motion programs as a 
simple flowchart. This makes it easy to see exactly how your finished application 
will run.

The flowchart editor looks something like this:

In the page itself, two buttons to the right of the flowchart open wizards that let 
you add new motion blocks to the target.
■ Click Add Homing Motion to add one of many predefined homing motions.

■ Click Add Motion to add a predefined non-homing motion, or to use the 
Motion Calculator (see page 93).

After adding the desired motion blocks, click Finish to return to the flowchart 
editor.

Want to know more? In the Help Index, look up “Motion Application Builder”.

The Application Builder toolbar (see below). Click these buttons 
to perform operations on the program or selected step.

A Motion step. You can select from any of the target’s Motion 
blocks. To add new motion blocks to a target, click the Add 
Homing Motion or Add Motion buttons.

The selected step. Click a step to select it.

The “True” branch from a conditional step (see page 92). If MB 
is True, the program skips the DO7=Off step.

Use the scroll bar to scroll up and down through the flowchart.
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Special Wizards5
Bas i c  f l owcha r t  s tep  types The flowchart is composed of the following basic step types.
■ Start and End steps: Flowchart execution begins at the Start step. When 

execution reaches the End step, the program stops.
■ Logic steps: Performs a logic-oriented action, such as setting or resetting a 

particular register.
■ Motion Program steps: Performs a motion program action, such as starting or 

stopping a program.
■ Motion block steps: Runs a motion block.
■ Delay steps: Pauses program execution. 
■ Conditional and Connector steps: Evaluates a given condition and branches 

execution depending on the results. For more details, see Conditional Steps on 
page 92 (or look up “Connecting and disconnecting conditional steps” in the 
online help).

■ User-defined steps: Performs a piece of motion script entered by you.
■ Remark steps: Lets you insert a comment into the flowchart. Remarks are 

included in the script downloaded to the motion controller.
■ Comment steps: Lets you insert a comment into the flowchart. Comments are 

not included in the script downloaded to the motion controller.

Conditional steps are described in greater detail below.

Cond i t i ona l  s t eps Conditional steps represent a simple conditional statement. When program 
execution reaches a conditional step, it branches depending on a specified 
expression:

■ If the expression is True, execution branches to the right (indicated by a “T”).
■ If the expression in the statement is False, execution branches downward.

You can choose from several conditional expressions, including several that refer 
to fault registers. Selecting a conditional step or connector highlights the line 
connecting it to its partner.

Want to know more? In the Help Index, look up “Application Builder step types”.

Any steps here are only executed if FI = 0 (that is, if 
the expression is false).
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Special Wizards
To  i n s e r t  a  n ew  s t ep  i n t o  t he  App l i c a t i o n  Bu i l d e r  f l owc ha r t
1. In the Application Builder flowchart, select the step immediately preceding the spot where the new step will go.

To add a step to the beginning of the flowchart, select the Start step.

2. Click the Add Command button on the Application Builder toolbar.
In the menu that appears, point to the type of command or step you want to add, 
then select the exact step from the submenu. Connector steps, Comments, and 
User-defined steps are found under the Standard Elements option.
Some command types may be unavailable depending on your project. For 
example, you cannot add a Motion step until the target has some motion blocks.

3. The new step appears after the originally-selected step.
If necessary, you can move the step to a different position, or (if appropriate) edit 
the step’s parameters.

To  ed i t  a  s t e p  i n  t h e  Ap p l i c a t i o n  Bu i l d e r  f l ow cha r t
• In the Application Builder, do one of the following:

■ Double-click the step.

-or-

■ Select the step, then click Edit Command on the Application Builder 
toolbar.

-or-

■ Select the step, then press CTRL+E.
Only certain steps have parameters that can be edited. If a selected step cannot be 
edited, the Edit Command button is disabled.

M o t i o n  C a l c u l a t o r

The Motion Calculator is the default editor for motion blocks. With it, you can 
create simple incremental motion blocks based on mathematical calculations, 
viewing the results of changes as you make them.

You can open the Add Motion wizard by right-clicking the Motions folder in the 
Navigator and selecting Wizard. Unless you configure a motion block to be edited 
as text, the Motion Calculator also opens when you right-click a motion block and 
select Open.
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Special Wizards5
The Motion Calculator looks something like this:

Typically, you’d enter desired values in the Data column and click Calculate. The 
Motion Calculator updates the appropriate values in the Calc column and draws a 
velocity/time graph of the calculated motion. Units in this graph are based on 
those in the Units column.

When entering values into the calculator, keep in mind the following:
■ You can fill in two (and only two) of Velocity, Total Time, and Distance. That is, 

one of these parameters must be left at 0 and the other two filled in with non-
zero values. The Motion Calculator automatically calculates the missing 
parameter in the Calc column.

■ If you leave Acceleration time (Acc. Time) or Deceleration time (Dec. Time) as 
0, they are set to one-third the total time for the motion. You can override this 
by filling in the appropriate parameter.

When the motion is configured the way you want, click Add Motion (above the 
calculator in the wizard page) to add the motion block to your application.

Click one of these to select the kind of motion you want.

Click these buttons to zoom in and out of the graph of the 
plotted motion.

Click the arrows to pan around the graph of the plotted motion,

Click here to print the graph of the plotted motion on the 
default printer.

You can enter values for two of these three parameters. (The 
third is calculated.)

Enter new values for Acceleration time and Deceleration Time 
to override the defaults.

Click here to clear all values for the current motion.

Calculated values appear in the Calc column.

Enter your own values in the Data column.

Click here to fill in the Calc column and view (or update) a velocity/time graph of the calculated motion.
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CAM Profile Editor
C A M  P R O F I L E  E D I T O R
The Motion Developer CAM editor lets you create and edit a single electronic 
CAM profile for a motion controller target. The CAM profile is a curve that specifies 
the response of a slave servo to a master position index. The CAM profile is written 
to the target’s configuration script.

You can edit a target’s CAM Profile by double-clicking on its CAM_Profile node. 
The CAM editor display looks something like this:

You can adjust the curves of your CAM profile to suit the specific needs of your 
project. With the CAM editor you create profiles by defining points on a 
master/slave position curve. Groups of adjoining points are allocated to sectors. 
Each sector is assigned a polynomial curve fit order (1,2,3) that specifies how the 
curve will be interpolated between points.

To include CAM Profile data when downloading your project, ensure that the 
target’s Include CAM Points property is True. When downloading a project to a 
target with a defined CAM Profile, Motion Developer automatically converts the 
curve to a series of CAMx=value commands. These commands are added to the 
target’s configuration script.

Curves of the profile 
can be adjusted and 
edited graphically

Secondary curves show 
the velocity, 
acceleration and jerk of 
the CAM profile.

The CAM profile table allows
numeric editing and curve order

grouping

The Companion tracks your
moves and provides information

on what you click.

Double-click the CAM_Profile
node in the Navigator to open the

CAM editor.
Getting Started 95GFK-1868D



M o t i o n  D e v e l o p e r

CAM Profile Editor5
The number of CAMx commands added to the configuration script depends on the 
target’s CAM Point Resolution property.
■ If CAM point Resolution is 1 degree, 360 CAM commands are added to the 

script.
■ If CAM point Resolution is 0.1 degrees, 3600 CAM commands are added to the 

script.

Downloading 3600 CAM commands can be very time-consuming. It is 
recommended that you use a Resolution of 1 degree, at least during the initial 
development stages.

T o  ed i t  a  m o t i o n  c on t r o l l e r  t a r ge t ’ s  C AM  p r o f i l e
• In the Project tab of the Navigator, under the motion controller target whose CAM you want to enter, right-click 

CAM_Profile and choose Open Profile.
The CAM editor opens with the target’s CAM profile.
For more details on using the profile editor, look up “Editing a Motion CAM 
Profile” in the online help.

Want to know more? In the Help Index, look up “Motion Developer CAM Editor: an 
Overview”.
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6 Local Manager
The Local Manager is Machine Edition’s local systems and project manager. It is 
the version control, security, and audit trail system for your automation and 
control development process.

You do not need to use Local Manager to work with Machine Edition products. 
However, if you have security concerns, or if you want to track your application 
development process, it can be very useful.

Navigator: Manager tab

Project nodes
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Local Manager6
L O C A L  M A N A G E R
The Local Manager refers to Machine Edition’s project and systems management 
features. Local Manager features let you:

■ Keep track of changes made to projects and settings, and keep a history of 
previous versions of projects (see Version Control, page 99).

■ Control access to projects and settings under CIMPLICITY Manager (see Access 
Control, page 104).

■ Monitor and record actions performed by users (see Audit Trails, page 107).

The Local Manager must be enabled before you can use its features. While 
enabled, users of Machine Edition on the local computer will have to log on to the 
Manager system. As the name implies, the Local Manager only works with projects 
stored on the local computer. 

To  en ab l e  L o c a l  Man age r
1. On the File menu, point to CIMPLICITY Manager, then select Enable Local Manager.

If Disable Local Manager appears instead, then the Local Manager is already 
enabled.
If Enable Local Manager is grayed out, then the Local Manager components 
weren't included when installing CIMPLICITY Machine Edition. You will have to 
reinstall Machine Edition from the installation CD, making sure to enable the Local 
Manager component.

2. Exit and restart Machine Edition.

3. Log on to the Manager system.
Since this is the very first time the Local Manager has been enabled on this 
computer, you will have to log in as the Administrator user. Type "Administrator" 
for the user name, and leave the password blank.
Several new folders are now available. These are Access Control, Audit Trail, 
and Local Manager (under the Projects folder).

4. Set up your Access Control system.
Create Users and Groups for people who need access to items on the 
computer (for details, see chapter 7). You can work with other new features 
(adding existing projects to Local Manager or setting up Audit Trails) later.

Want more? Additional system management features—such as scheduled events and a centralized 
Server for project and database storage—are available with the CIMPLICITY Manager product.

Want to know more? In the Help Index, look up project history and choose “Setting up a Local 
Manager system”.
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Version Control
V E R S I O N  C O N T R O L
Version Control is probably Local Manager’s most important feature. With Version 
Control, all your data is stored in a central location. It also allows you to:

■ ensure that only one user can make changes to an item or project at a time;

■ keep track of who is currently working on an item or project;

■ safely store previous versions of projects; and

■ return a project to a previously-archived version.

Note: With Local Manager, only the previous ten versions are retained.

All Local Manager projects and settings are stored in a separate database. When 
you want to work on something under a Local Manager system—whether it’s a 
project, Access Control settings, or something else—you go through the following 
steps:

1. Check out the project or item.
Local Manager copies the item to a separate working directory and marks the item 
as being “checked out”. As long as the item is checked out, no other user can 
make changes to that item.

2. Make changes to the item.
Changes are made in the working directory only. At this point, the version stored 
by the Local Manager system is unchanged.

3. When you are finished, check in the item.
Local Manager copies the updated version from the working directory and 
removes the “checked out” flag. Other users can now check the item out to make 
more changes later.

Secur i ty  f or  Ver s i on  Contr o l Security in Local Manager is called Access Control and is explained in detail on 
page 104. Briefly, each user that is created in Local Manager is a member of one or 
more groups that have security permissions assigned to them. These permissions 
let users of that group perform certain actions. In addition, each project has one or 
more groups assigned to it. Users can only work with a project if they are a 
member of a group assigned to that project.

Want to know more? In the Help Index, look up version and choose “How Version Control works 
under Local Manager”.

Want to know more? In the Help Index, look up “Access Control Permissions”.
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Version Control6
Proj e c t  h i s to ry When you check in a project to the system, Local Manager automatically archives 
the old version. (Old versions of other items, such as Access Control user/group 
lists, are not archived.) You can get a report of all archived versions of a project by 
right-clicking it and selecting History Report. History reports appear in the Reports 
tab of the Feedback Zone.

In the Feedback Zone, right-clicking a previous version of a project gives you the 
following commands:

■ Get: Get a copy of the selected version onto the local computer.

■ Label: Assign a label to the selected version.

■ Make Latest Version: Make the selected version the current version.

Che ck ing ou t  o ther  i t ems Projects aren’t the only things you can check out. Local Manager also places the 
following under Version Control:

■ The Access Control database (see page 104)

■ Audit Trail settings (see page 107)

For example, to edit a user’s security permissions, the Administrator would check 
out the Access Control database, make the desired changes, then check it back 
in.

C r e a t i n g  a n d  A d d i n g  P r o j e c t s  t o  L o c a l  M a n a g e r

There are three ways to get a project into the Local Manager system:

■ You can create a new project on the Server. For more information, see “To 
create a new project” on page 101.

■ If there are any existing projects on your system not under Local Manager, you 
can move them there. In the Navigator, these projects appear under the My 
Computer folder. To add them to Local Manager, right-click the project and 
select Add to Server.

■ If you have a project exported or backed up, you can restore it directly into 
Local Manager. For more information, see “To add a previously-created project 
to Local Manager” on page 101.

Under Local Manager, projects are stored under the Local Manager folder, itself 
located under the main Projects folder. Any new projects you create are located 
in that folder.

Want to know more? In the Help Index, look up project history and choose “Project History 
Reports”.
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Version Control
T o  ope n  a  p r o j e c t  w he n  u s i n g  L o c a l  Man a ge r
1. In the Manager tab of the Navigator, under the Projects folder, right-click the project you want to open and 

select Open.
The Projects folder is divided into two folders.

■ My Computer contains Machine Edition projects that have not been added 
to the Local Manager system.

■ The Local Manager folder contains all projects managed by the Local 
Manager system. Under this folder, you must have a project checked out to be 
able to open it.

T o  c r e a t e  a  n e w p ro j e c t
You must have the proper Access Control permissions to perform this task.

1. In the Manager tab of the Navigator, under the Projects folder, right-click the Local Manager folder and 
select New. The New Project dialog box appears.
You cannot create a new Machine Edition project if a project is already open. 

2. Type a unique project name (maximum 32 characters). 

3. Select a project template. 
A sample of the project appears in the Project Template dialog box.

4. Click OK.
The project is created on the Server. If you’re creating a new Machine Edition 
project, it is automatically checked out and opened.
Once you create a new project on the Server, it is recommended that you also add 
groups to the project, to allow users access to it. For more information, see “Access 
Control” on page 104.

To  add  a  p r ev i o u s l y - c r e a t ed  p r o j e c t  t o  L o c a l  Man age r
You must have the proper Access Control permissions to perform this task.

• In the Manager tab of the Navigator, under the My Computer folder, right-click the project you want to add and 
select Add.
The project moves from the My Computer folder to the Local Manager folder. It 
is also automatically checked out by you.
Once you create a new project on the Server, it is recommended that you also add 
groups to the project, to allow users access to it. For more information, see “Access 
Control” on page 104.
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Version Control6
T o  c he c k  ou t  a  p r o j e c t  o r  i t em  f r o m  t h e  S e rve r
• In the Manager tab of the Navigator, right-click the project you want to check out, and select Check Out.

To check out a project, the project must not be already checked out by anyone. 
You must also be logged onto the Local Manager system and have the CIMPLICITY 
Manager CheckInOut permission. 
Local Manager copies the item to the user’s local computer (the “client” 
computer), and marks the item as being “checked out”. As long as the item is 
checked out, no other user can make changes to that item.

T o  c he c k  i n  a  p r o j e c t  o r  i t e m  t o  t he  Se rv e r
1. In the Manager tab of the Navigator, right-click the project you want to check in, and select Check In. 

The project must be closed and checked out by the current user on the current 
client computer. You must also be logged on to the Local Manager and have the 
CheckInOut permission. 

2. Select from the available options.

■ Remove local copy: Removes the copy of the project from the working 
directory after the check in is complete. 

■ Keep local copy: Keeps a copy of the project in the working directory after the 
check in is complete. If the project is not a Machine Edition project, it is marked 
as read-only. 

■ Keep checked out: Updates the version in Local Manager with your changes, 
but keeps the project checked out. 

3. (Optional) Include a comment (maximum 256 characters) of the changes made while the project was checked out. 

4. Click OK.
Local Manager copies the updated version from the working directory to the Local 
Manager system.

T o  v i e w  a  p r o j e c t  h i s to r y  r e p o r t
• In the Manager tab of the Navigator, under the Local Manager folder, right-click the project for which you want a 

history report and select View History Report. 
A history report appears on the indicated project. You can right-click versions in 
the project history report for an additional menu of commands.

Want to know more? In the Help Index, look up project history and choose “Project History 
Reports”.
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Version Control
To  u n do  a  c he c k  o u t  o f  a  p r o j e c t  o r  i t em
1. In the Manager tab of the Navigator, right-click the project you checked out, and select Undo Check Out. 

Normally, to undo a check out, the item must be checked out by you on the 
current computer. You must also be logged on to Local Manager, and have the 
CheckInOut permission. 
If the item is checked out by someone else (or by you on a different computer), you 
can still undo the check out if you have the OverrideCheckOut permission. 

2. If you’re undoing a check out of a project, in the Undo Check Out dialog box, select one of the following option(s), 
and then click OK.

■ Remove local copy: Deletes the working copy of the project.

■ Replace local copy: Overwrites the working copy with the version in Local 
Manager.

■ Keep checked out: Keeps the project checked out so you can continue working 
on it, but cancels the changes you made since you last checked it out. This 
option is only available with the Replace local copy option. 

■ Leave local copy as is: Keeps a read-only copy of the project with the changes 
you made while it was checked out. 
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Access Control6
A C C E S S  C O N T R O L
The Access Control folder in the Navigator’s Manager tab contains these items:

■ Users represent individual users. When you log on to a Manager system, you 
must identify which User you are.

■ Groups are groups of Users. Each group is assigned a set of permissions. 
Users in a group inherit its permissions.

■ Permissions are security settings assigned to groups. In general, a permission 
allows or disallows a particular action or set of actions. 

Casually, we say that a user “has” a permission if they’re a member of a group for 
which that permission is set to True. Most permissions are True/False settings; 
exceptions are documented in the online help.

Administrators do not assign permissions to individual users. Instead, they assign 
permissions to groups, then add users to those groups. This lets an administrator 
assign permissions to a set of users with similar roles and responsibilities.

Under a group node, permissions are organized based on the feature or 
application they’re associated with. You configure the actual permissions in the 
Inspector. For example, selecting a group’s CIMPLICITY Manager permissions 
node makes permissions that control access to Manager features appear in the 
Inspector. By setting the appropriate permission in the Inspector, you allow or 
disallow access to specific Manager features for that group.

■ For more details on specific permissions, select its permissions node in the 
Navigator and press F1. Or, for a short description, ensure the Companion 
window is open and select the permission in the Inspector.

Users can be members of more than one group. If this is the case, they get the most 
advantageous set of permissions for all groups they are a member of.

T h e  A c c e s s  C o n t r o l  D a t a b a s e

A list of users and groups are stored in the Access Control database. To make any 
changes to users, groups, or permission settings (including adding new users or 
groups), you must first check out the Access Control database. The changes you 
make don’t take effect until the Access Control database is checked back in to the 
Local Manager system.

Each computer running Local Manager maintains its own Access Control database. 
If you need to work on projects from more than one computer, you must be added 
as a user to all of them.
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A c c e s s  C o n t r o l  o f  P r o j e c t s

Access Control for projects depend on which groups are assigned to the project. 
The users or members of a group that are assigned to a project can check the 
project in and out, as long as they also have the CIMPLICITY Manager CheckInOut 
permission (see “To assign a group to a project or layout” on page 106). Since 
users can only edit a project when it’s checked out of the Server, this lets the 
administrator control who can make changes to a given project.

System Groups  and  User s The following groups and users cannot be deleted:

■ Administrators group: This group has every available permission and is 
automatically assigned to every project managed by CIMPLICITY Manager.

■ Everyone group: All users on a Server are members of the Everyone group, and 
have minimal permissions. By assigning a permission to the Everyone group, 
you can assign that permission to every user in the Access Control database.

■ Administrator user: The Administrator user is a member of the Administrators 
group. When you start Local Manager for the very first time, you must log in as 
the Administrator.

■ Guest user: The Guest user can be assigned to any group and inherits that 
group’s permissions.

T o  c r e a t e  a  n e w us e r
1. In the Manager tab of the Navigator, right-click the  Access Control folder, and select Check Out Access Control.

2. Under the Access Control folder, right-click the Users folder and select New User. 

3. Type a name for the user.
User names can only use the characters 0-9, a-z, A-Z, and _. Spaces are not 
allowed in the user name, and the maximum number of characters is 20. 

4. Configure the user’s properties in the Inspector.

T o  c r e a t e  a  n e w g ro up
1. In the Manager tab of the Navigator, right-click the  Access Control folder, and select Check Out Access Control.

2. Under the Access Control folder, right-click the Groups folder and select New Group. 

3. Type a name for the group.
Group names can only include the characters 0-9, a-z, A-Z, and _. Spaces are not 
allowed in a group name, and the maximum number of characters is 20. 

4. Type a description for the group in its Description property in the Inspector.
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Access Control6
T o  a s s i g n  p e rm i s s i o n s  t o  a  g r o up
1. In the Manager tab of the Navigator, right-click the  Access Control folder, and select Check Out Access Control.

2. Under the Access Control folder, in the Permissions section of the Group folder, right-click the type of 
permissions you want to set, and select Properties. 
Except for custom project permissions, you cannot edit permissions for the 
Administrator group.

3. Configure the properties in the Inspector window. 
For more details on specific permissions, select its permissions node in the 
Navigator and press F1. For a short description, ensure the Companion window is 
open and select the permission in the Inspector.

To  add  a  u s e r  t o  a  g r ou p
1. In the Manager tab of the Navigator, right-click the  Access Control folder, and select Check Out Access Control.

2. Under the Groups folder, right-click the Users folder of an individual Group and select Add User. Select 
a user from the list that appears. 

- or - 

In the Users folder (directly under Access Control), right-click the User you want to assign to a group and 
select Add to Group. Select a group from the list that appears. 

To  a s s i g n  a  g r oup  t o  a  p r o j e c t  o r  l a yo u t
To add a group to a project, you must be a member of a group that has the 
EditProjectList permission. To add a group to a layout, you must have the 
EditLayouts permission.

1. Check out the project you want to add a group to. 

2. In the Manager tab of the Navigator, right-click the project you checked out and select Add Group. 

3. Choose one of the groups in the list.
The group is added to the project along with its permissions and users. 

4. Check in the project. 

Want to know more? In the Help Index, look up permissions and choose the appropriate 
permissions topic.
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A U D I T  T R A I L S
CIMPLICITY Manager can track and record actions performed by its users. If a user 
performs an action and the administrator has flagged that type of action to be 
audited, a record is logged in the audit trail database.

You specify which actions to track by configuring the Server’s audit trail settings. 
Located under the Audit Trail folder in the Navigator, audit trail settings are 
grouped by feature or product type.

The settings are configured in the Inspector. If an audit trail setting is set to True, 
Local Manager tracks and records all actions of that type. For example, if the 
CIMPLICITY Manager audit trail setting PasswordChange is set to True, Local 
Manager logs a record every time a user’s password is changed.

T h e  A u d i t  T r a i l  D a t a b a s e

Audit trail records are added to Local Manager’s audit trail database, which is 
stored in Microsoft Access™ format. You can use Microsoft Access (or another 
application capable of reading Microsoft Access databases) to view, sort, and 
generate custom reports on audit trail records. Though not as simple as the Audit 
Trail Report Manager, this gives you the most flexibility in searching the audit trail 
database.

The audit trail database file is located on the CIMPLICITY Manager Server 
computer under “...\CIMPLICITY Machine Edition\fxServer\Audit 
Database\Audit.mdb”, where “...\CIMPLICITY Machine Edition” is the Machine 
Edition installation directory.

Since audit trail records are constantly being logged to the Server, the audit trail 
database file can get very large. It’s a good idea to occasionally archive the 
database file to another computer to free disk space on the computer.

T o  ed i t  A ud i t  T r a i l  s e t t i n g s
1. In the Manager tab of the Navigator, right-click the Audit Trail folder, and select Check Out Audit Trail.

2. Under the Settings folder, right-click on CIMPLICITY Manager, Scheduler or the project type whose audit trail 
settings you want to edit, and select Properties.

3. Edit the settings for your selection in the Inspector window. 
For a description of a particular audit trail setting, ensure the Companion 
window is open, and click the audit trial setting in the Inspector. 
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Audit Trails6
T o  a r c h i v e  t he  A u d i t  T r a i l  d a t a b a s e
1. In Windows Explorer, move the Audit Trail database file (*.mdb) from the Server computer to the computer you 

want to archive the database to. 

The audit trail database file is located on the CIMPLICITY Manager Server 
computer under “...\CIMPLICITY Machine Edition\fxServer\Audit 
Database\Audit.mdb”, where “...\CIMPLICITY Machine Edition” is the Machine 
Edition installation directory.

2. Rename the moved file so that the next time you archive the database, you won’t overwrite the previously archived 
file. 
Include the current date in the new file name to make it easier to find in the future. 
Local Manager will create a new audit trail database file the next time an audit trail 
action is recorded. The file will have the same name, and will be created in the 
same directory you moved the database from.
You can view records in an archived database by opening the archived file in any 
database or report application capable of reading Microsoft Access™ databases.

A u d i t  T r a i l  R e p o r t s

The easiest way to view records in the audit trail database is through the Audit 
Trail Report Manager, located under the Reports folder in the Audit Trail folder. 
To open the Report Manager, right-click the Audit Trail Report Manager node 
and choose Open.

Generated Audit Trail Reports can be displayed on screen and, if desired, sent to a 
printer. 

■ If you have an application that can read Microsoft Access databases, you can 
use it to view and sort audit trail records.

To  g ene r a te  a n  A ud i t  T r a i l  r e po r t
1. In the Reports folder, right-click Audit Trail Report Manager and select Open. The Audit Trail Report 

Manager dialog box appears.
The very first time you open the Audit Trail Report Manager you will be asked to 
locate the audit trail database file (*.mdb) on the Server computer. 

The audit trail database file is located on the CIMPLICITY Manager Server 
computer under “...\CIMPLICITY Machine Edition\fxServer\Audit 
Database\Audit.mdb”, where “...\CIMPLICITY Machine Edition” is the Machine 
Edition installation directory.

2. Select the Report Template you want to create. 

3. Configure the following settings for the report.
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Audit Trails
■ Select a Date range. 

■ Set the Filters you want to use. 

■ Select how you want the report sorted (by date, user, computer name, or 
project name). 

■ Select the page size. 

4. (Optional) If you want to print the report, select a printer.
Select Default to print the report on the printer configured as the Windows default. 

5. Click Print Preview.
The Report Viewer dialog box displays the report you requested. You can then 
print or save the report to a file. 
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correcting, errors 28
creating

actions 40
alarm groups 66
alarm groups (QuickPanel) 79
alarm objects 66
alarm objects (QuickPanel) 79
application scripts 60, 81
custom web documents 71
groups 105
logging groups 65
macros 36
panel scripts 60, 81
panels 58
projects 14, 26, 57, 101
SFCs 35
subroutines 40
touch animation scripts 61
users 105
variables 26

custom web documents 71
customer support 6

D
Data Watch 41
debugging scripts 73
developing.  See creating
DeviceNet 49
devices

motion control 84
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devices, adding PLC 67
downloading 25, 28, 53

CE targets 29
motion device targets 28
NT targets 29

drawing graphical objects 59
drawing tools 59
drive targets, motion 85
drivers

adding
Control I/O 50
PLC Access I/O 67

ASCII 49
Control I/O 49, 50
Control Peer 49
OPC Client 68
PLC Access I/O 67

E
editing

application scripts 60, 81
CAM profiles 96
custom web documents 71
ladder programs

offline 40
online 41

logging groups 65
motion scripts 88
panel scripts 60, 81
panels 58
quick editing

ladder program 41
SFCs 37

quick test 31
SFCs

offline 36, 44, 45, 48
online 38

steps, flowchart 93
editors

grid (QuickPanel) 76, 78
ladder 39
panel 58
QuickPanel panel 77
script 60, 81

errors and warnings
correcting 28
Feedback Zone 20

Everyone group 105
external keypad 80

F
Factory Client 2000.  See CE targets
Factory Layouts

assigning groups to 106
Feedback Zone 20
fixing, project errors 28
flowchart editor See Application 
Builder
flowchart steps See steps, flowchart

G
GE Fanuc Genius 49
getting help 11
getting projects 102
global function library scripts 60
graphical objects 58, 59
graphical panels.  See Panels
grid editor

alarms 78
keypad assignment 80
messages 79

groups 104
adding users to 106
assigning to projects and 

layouts 106
creating 105
LID (Local Image Display) 76
system 105

Guest user 105

H
hard real-time

Controller 54
VenturCom RTX 54

hardware
motion devices 84

help 11
history report 100
Honeywell SAS 49

I
I/O

configuring
Control 51
PLC Access 67

Control 50
OPC 68
PLC Access 67

IEC addresses 51
Import tab 20
index, search 11
InfoView tab 14
InfoViewer 12
inserting

ladder instructions 40
motion script items 88
rungs 40
script functions 63
SFC instructions 37

Inspector 16
installing Machine Edition 3
Internationalization.  See Languages 
folder

K
keypad assignment 80
keyword search 11

L
labels 39
Ladder Editor 39

offline 40
online 41

ladder instructions 40
ladder programs

defined 39
editing

offline 40
online 41

opening 39
quick editing 41

Language translation 73
Languages 73
Languages folder 73

adding new languages 74
default language 75
grid 74
renaming languages 74

Languages grid 74
display font 75
updating Source language 75

LID groups 76
Local Image Display (LID) 80
Local Image Display groups 76
Local Manager 97
Local Manager system

add projects to 101
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check in to 99
check out from 99

Local Message Display (LMD) 79
local projects

adding to Local Manager 101
locating

labels 39, 43, 44, 45, 46, 47, 
48

variables 36, 40, 44, 47
logging data 65
logging groups 65
logging strategies 65
Logic Developer

PC 33 to ??
Logic Developer - PC 33 to 56
logic, adding 34

M
Machine Edition

downloading 28
environment 10
getting help 11
key features 11 to 21
Logic Developer - PC ?? to 55
OPC servers 69
projects 14, 23
properties 16
toolbars 13
validating 28
View 57 to 82

macros 35, 36
Main Motion Wizard 90
Manager tab 14
Manager, Local 97
message grids 79
messages 79

Local Image Display (LID) 80
Local Message Display (LMD) 79
Triggered Message Display 

(TMD) 79
Messages tab 20
Modicon Quantum 800 49
Motion applications

configuration script 86
programs 86

motion applications 85
motion blocks

about 87
editing with calculator 93

opening 85
switching editors 86

Motion Calculator
about 93
using 94

motion configuration 86
opening 85

Motion Developer
applications 85
supported hardware 84

Motion programs
fault-handing program 86
opening 85
switching editors 86

motion programs 86
motion scripts 88
motion targets 85
Motion Wizards

about 89
Application Builder 91
Controller Functions 90
Main Wizard 90
navigating through 89
See also Motion Calculator
special wizards 91

moving product authorization 5
multi-language support.  See 
Languages folder

N
Navigator 14

property column view.  See 
Property column view

networking 72
NT computers.  See NT targets
NT targets 23, 25

downloading 29

O
objects.  See graphical objects
offline

Ladder Editor 40
SFC Editor 36, 44, 45, 48

online
Ladder Editor 41
SFC Editor 38
to the Controller 25

online help 11
OPC 68

client 68
server links 68, 69
servers 69

opening
application scripts 60, 81
ladder programs 39
macros 35
motion blocks, motion programs, 

and motion 
configuration 85

panel scripts 60, 81
panels 58
projects 15, 23, 26, 34, 57, 83, 

101
SFCs 35

Options tab 15
options, user preferences 15

P
Panel Editor 58, 77

animation 58, 59
graphical objects 58
working with 59

panel scripts 60, 63, 81
panels 58, 77

quick testing 31
peer driver, control 49
permissions 104

assigning 106
PLC Access I/O 67
preview panels.  See quick test
product authorization

authorizing Machine Edition 4
moving to another PC 5

profiles, CAM See steps, flowchart
programs, motion See motion 
programs
Project History 100
Project tab 15
Projects 99

Access Control 104
adding to Local Manager 101
assigning groups to 106
checking in 102
checking out 102
creating 101
getting copies of 102
history report 100
opening 101
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projects 14
backing up 14
creating 26
downloading 28
Motion Developer 83
opening 15, 23, 26, 34, 57, 83
running 23, 72
validating 28
with HMI component 57
with logic component 34

properties 16
configuring 21

Property column view 21
Property Inspector.  See Inspector

Q
QPScript language 82
quick editing

ladder program 41
SFCs 37

quick start 8
quick test, panels 31
QuickPanel alarm groups 78
QuickPanel alarm window 78
QuickPanel Applications 76
QuickPanel Grid Editor 76, 78
QuickPanel Panel Editor 76

R
References tab 20
remote views 71
Reports

variable 22
Reports tab 20
requirements, hardware and 
software 2
rungs 39

inserting 40
write changes 42

running
Controller 54
projects 23, 72
sample applications 23
View Runtime 72

S
sample applications 23
scan cycle, Controller 52
script commands.  See script functions

Script Editor 60, 81
inserting script functions 63
scripts 60, 81
working with 63

script functions 63
scripting languages

Active scripting 62
QPScript 82
VBScript 61
ViewScript 61

scripts 60, 81
application scripts 60, 81
debugging 73
global function library scripts 60
inserting script functions 63
motion 88
panel scripts 60, 81
touch animation scripts 60

scripts, motion
inserting items 88

search, index 11
security. See Access Control
Sequential Function Charts.  See SFCs
servers

networking 72
OPC 69

setting.  See configuring
settings

audit trail. See Audit Trail settings
SFC Editor

offline 36, 44, 45, 48
online 38

SFC instructions, inserting 37
SFCs

editing 36, 44, 45, 48
opening 35
quick editing 37

shortcut keys, View Runtime 72
shunts 40
Smart Lists 18
steps, flowchart

conditional 92
editing 93
inserting 93
step types 92

subroutines 40
support 6
switching editors, motion blocks and 
motion programs 86
System groups and users 105

system requirements 2

T
tags.  See variables
targets 23, 25

motion 85
technical support 6
testing

panels 31
scripts 73

toolbars
drawing tools 59
ladder instruction tools 40
Machine Edition tools 13

Toolchest 19, 40
tools

Companion 12
Control I/O 50
Data Watch 41
Feedback Zone 20
InfoViewer 12
Inspector 16
Navigator 14
overview 10
toolbars 13
Toolchest 19, 40

touch animation scripts 60
tracking

see Audit Trailing
translations.  See Languages folder
Triggered Message Display (TMD) 79

U
undoing check outs 103
Unused Variable report 22
user preferences 15
users 104

adding to groups 106
creating 105
system 105

V
validating 20, 28, 53
Variable

property column view 21
Variables 21

managing 21
reports 22

variables
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creating 26
locating 36, 40, 44, 47

Variables tab 15, 21
VBScript language 62
VenturCom RTX 54
Version Control 99

security 101
View 57 to 82

testing the HMI 31
View Runtime 72

running 72
shortcut keys 72

ViewScript language 61

W
Warm Standby 55

and OPC servers 55
configuring 56
configuring OPC server for 56

Web Access 70

Site Index 70
Windows CE targets.  See CE targets
Windows NT targets.  See NT targets
windows.  See Panels
wizard, Controller Functions 90
Wizard, Main 90
wizards, motion See Motion Wizards
writing motion scripts 88
writing scripts 63
Getting Started 115GFK-1868C


	Contents
	Welcome
	System Requirements
	Installation
	To install Machine Edition from a CD

	Product Authorization
	To authorize a copy of Machine Edition
	To move the authorization to another computer

	Technical Support
	North America
	South America
	Europe


	Machine Edition
	Quick Start
	To start Machine Edition

	The Machine Edition Environment
	Getting to Know Machine Edition
	Right-click, right-click, right-click
	Getting Help
	Accessing the Right Tool
	Projects and the Navigator
	To open a project in the Navigator

	Properties and the Inspector
	Data Watch Lists
	To define a Watch List:

	Smart Lists
	The Toolchest
	The Feedback Zone
	Managing Variables

	Machine Edition Projects
	Running a Sample Project (View/Logic Developer - PC)
	To run a sample project
	To go online to the Controller

	Developing a Machine Edition Project
	To create and develop a project

	Validating and Downloading a Project
	Preparing a Remote NT target for Downloading
	Preparing a Windows CE Target for downloading

	Testing a View Project
	To Quick Test changes made to a graphical panel



	Logic Developer - PC
	To create a project that includes a logic component
	To add a logic component to an existing project
	To add a user-defined folder to your project
	SFC Editor
	Sequential Function Chart
	To add a new SFC
	To open an SFC or macro for editing
	To create a new SFC macro

	Working with the SFC Editor - Offline
	To insert an SFC instruction
	To Quick Edit an SFC

	Working with the SFC Editor - Online
	To go online to the Controller’s SFC


	Ladder Editor
	Ladder Program
	To open a ladder program for editing
	To locate a label
	To create a new subroutine or action

	Working with the Ladder Editor - Offline
	To insert a rung
	To Quick Edit ladder logic

	Working with the Ladder Editor - Online
	To go online to the Controller’s ladder program
	To write a changed rung to the Controller


	Instruction List Editor
	Instruction List
	To open an IL block for editing
	To create a new IL block

	Working with the IL Editor - Offline
	To insert an IL instruction

	Working with the IL Editor - Online
	To go online to the Controller’s IL


	Structured Text Editor
	Structured Text
	To open an ST block for editing
	To create a new ST block

	Working with the ST Editor - Offline
	To insert an ST instruction

	Working with the ST Editor - Online
	To go online to the Controller’s ST


	Control I/O Drivers
	I/O Drivers
	To add a Control I/O driver to a target

	Control I/O Tool
	Working with Control I/O
	To configure an I/O system with the Control I/O tool


	Controller
	Working with the Controller
	To configure the Controller
	To download a logic component to the Controller
	Run Mode Store
	To run the Controller
	To configure an HRT Controller
	To allow an HRT Controller to run following a Windows NT failure

	Warm Standby
	Working with Warm Standby
	OPC Servers and Warm Standby
	To configure Warm Standby
	To configure an OPC server for Warm Standby



	View
	To create a project that includes an HMI component
	Panel Editor
	Panels
	To create a new panel
	To open a panel for editing
	To configure a panel

	Working with the Panel Editor
	To draw a graphical object
	To animate an object


	Script Editor
	Scripts
	To create, open, and edit an application script
	To create, open, and edit a panel script
	To create a touch animation script
	To create a global function library script

	Scripting Languages
	Validating a script written in an Active Scripting language
	VBScript Syntax
	Active Scripting Objects

	Working with the Script Editor

	Logging
	To enable logging of a variable
	To create a new logging group
	To edit logging group properties

	Alarms
	Alarm Objects
	Alarm Groups
	To set an alarm condition
	To create an alarm group
	To create an alarm object


	PLC Access I/O
	Drivers
	To add a PLC Access driver to a target
	To add a device to a PLC Access driver


	OPC
	OPC Client
	To add an OPC Server link to the OPC Client folder

	Machine Edition OPC Servers

	Web Access
	To allow remote access to your project
	To access the Web Documents Site Index
	To view animated panels remotely
	To create a new Custom Web Document
	To edit a Custom Web Document

	View Runtime
	Networking
	To run a project from Machine Edition
	To run a project outside of Machine Edition
	To interact with View Runtime


	Languages folder
	Working with the Languages editor
	To add a new language column
	To rename a language column
	To move a language column
	To update entries in the Source column with new text entries in graphical panels
	To change the display font for a language:
	To set the default language column
	To delete a language column from the grid:


	QuickPanel Applications
	QuickPanel Panel Editor
	Panels on QuickPanel targets

	Grid Editors
	Alarms
	To create an alarm group
	To create an Alarm graphical object

	Message Displays
	External Keypad Assignment

	Scripts on QuickPanel Targets
	To create, open and edit an application script
	To create, open and edit a panel script
	QPScript Language


	Motion Developer
	To create a Motion Developer project
	About Motion Developer
	Supported motion control devices

	Motion Applications
	Motion targets
	To edit configuration scripts, motion programs, and motion blocks
	To switch between a wizard editor and the motion script editor

	Motion configuration
	Motion programs
	Motion blocks

	Motion Scripts
	Motion wizards
	Special Wizards
	Application Builder flowchart editor
	To insert a new step into the Application Builder flowchart
	To edit a step in the Application Builder flowchart

	Motion Calculator

	CAM Profile Editor
	To edit a motion controller target’s CAM profile


	Local Manager
	Local Manager
	To enable Local Manager

	Version Control
	Creating and Adding Projects to Local Manager
	To open a project when using Local Manager
	To create a new project
	To add a previously-created project to Local Manager
	To check out a project or item from the Server
	To check in a project or item to the Server
	To view a project history report
	To undo a check out of a project or item


	Access Control
	The Access Control Database
	Access Control of Projects
	To create a new user
	To create a new group
	To assign permissions to a group
	To add a user to a group
	To assign a group to a project or layout


	Audit Trails
	The Audit Trail Database
	To edit Audit Trail settings
	To archive the Audit Trail database

	Audit Trail Reports
	To generate an Audit Trail report



	Index

